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Syllabi
English
Objectives:  Specify Purpose
                          Question

                          Classify Main Ideas and Details

                          Locate Topic Sentences

                          State the Main Idea of a Sentence, Paragraph, or Passage

                          Infer the Main Idea using Patterns and Other Clues

                          Scan

                          Skim

                          Paraphrase

                          Summarize

                          Draw Conclusions

                          Identify Writing Patterns

                          Identify Author’s tone

                          Increase Speed of Reading

 Description:    The focus of this course is to introduce and enhance academic reading skills for         university-level students in Liberia.  Students will employ various reading strategies to increase comprehension when reading academic texts.  Students will paraphrase, summarize, and synthesize readings.  Students will respond, both orally and in writing, to written academic texts.  Student will also employ strategies to build their academic vocabulary.   Students will have ample opportunity to speak and write.  Grammar and pronunciation issues will be addressed as necessary.

Important concepts:  As stated in the Objectives section above, with the addition of plagiarism and collaboration.
Lesson Titles and Objectives:

L1:   Introduction To Course


Overview, Expectations, Introductions

L2:  Collaborating, Learning Styles, and Pre-Reading Strategies


Reading Title and Headings


Activating Background Knowledge of Topic

                Looking at Pictures and other Graphics

L3:  Pre-Reading Strategies Cont’d.


Predicting Purpose


Asking Questions


Vocabulary Strategy:  Guessing Meaning from Context.

L4: Pre-Reading Strategies Contd.

Reading First Paragraph

Reading First Sentence of Each Paragraph,

Reading Last Paragraph

Reading Section Headings

Vocabulary Strategy:  Synonyms 

L5: Determining the Topic and Stated Main Idea


Quiz on Pre-Reading and Vocabulary Strategies

L6:  Looking for Information and Increasing Reading Speed


Scanning

Skimming

Timed Reading

Vocabulary Strategy:  Restatement/Definition

L7:  Monitoring Comprehension


Asking Questions


Looking for Answers

L8:  Formulating Implied Main Ideas and Identifying Supporting Details


Inferences


Major and Minor Supporting Details


Outlining

L9:  Plagiarism, Summarizing, and Paraphrasing

             
Definitions and Differences

Quiz on Reading Strategies

L10:  Authors’ Writing Patterns


List Pattern, Sequence Pattern,  and Definition Pattern

L11:  Authors’ Writing Patterns cont’d.


Cause-Effect Pattern, Comparison-Contrast Pattern

Timed Reading

L12:  Reading Critically

Author’s Purpose, Intended Audience, and Point of View/Bias

L13:  Reading Critically Cont’d.


Author’s Tone and Intended Meaning

L14:  Thinking Critically


Definition

Problems:  Stereotypes, Either-Or, Ethnocentricity,  Accepting Information on Authority

Quiz on Writing Patterns

L15:  Thinking Critically Cont’d.


Facts vs. Opinions

Propaganda Devices


Well-Supported Argument

L16:  Thinking Critically Cont’d.


Inferences (again) 


Drawing Conclusions

L17:  Thinking Critically Cont’d.


Evaluating an Author’s Argument
L18:  Review


Summary


Questions

L19: Final Exam


Applications Lab - Engineering

Objective:

The hands on lab will allow students to investigate the concepts learned during their lectures by applying them to real life design while developing practical skills in prototype construction. In this process the students will learn to use their creativity in solving problems that do not have step-by-step instructions but a simple objective.

A series of short simple labs will be conducted for students to obtain key skills when working on hands on design. Additionally, three main projects will be performed through out the term: a statics lab, a dynamics lab and an energy lab.

Learning Objectives:

· Learn proper approaches for design 

· Obtain key best practices for hands on work and design including: appropriate safety when working with tools, measurements, estimation, project planning and design criteria 

· Utilize power and hand tools to create prototypes 

· Follow drawings to create prototypes 

· Apply the concepts of forces and force balances 

· Apply the concepts of projectile motion 

· Introduce energy harnessing and possible uses

Expectations:

1. Students are expected to behave professionally during the sessions and place safety first

2. No misbehavior will be tolerated around the tools 

3. Students will work on teams of 5 people 

4. Each team will conduct the labs in a collaborative manner 

5. Each individual in the team is expected to know what the lab requirements and skills are

6. and demonstrate that knowledge 

7. Reports will be expected for some of the labs 

8. The reports should be a team effort and should follow the formatting guidelines provided

9. in the sample report

Applications Lab - Agriculture

Objective:

The hands on lab will allow students to investigate the concepts learned during their Botany lectures by applying them to real life design while developing practical skills in prototype construction. In this process the students will learn to use their creativity in solving problems that do not have step-by-step instructions but a simple objective.
A series of short simple labs will be conducted for students to obtain key skills when working on hands on design. Additionally, three main projects will be performed through out the term: a statics lab, a dynamics lab and an energy lab.
Further, students will explore other components of agriculture beyond Botany.  Students will carry laboratories exploring biogas, oil pressing, and water.
Expectations:

1. Students are expected to behave professionally during the sessions and place safety first

2. No misbehavior will be tolerated around the tools 

3. Students will work on teams of 5 people 

4. Each team will conduct the labs in a collaborative manner 

5. Each individual in the team is expected to know what the lab requirements and skills are and demonstrate that knowledge 

6. Reports will be expected for some of the labs 

7. The reports should be a team effort and should follow the formatting guidelines provided in the sample report

Life Skills

Description:

In order to succeed in the engineering and agriculture profession, students must develop skills beyond the knowledge taught in engineering/agriculture courses. Furthermore, students must realize the importance of teamwork in their respective technical professions; developing a community amongst each other will not only help students succeed in their coursework, but further, will help the professions of agriculture and engineering work toward reaching their highest potential. 
Learning Objectives: 

1. Students will learn the value of creating a community amongst each other.

2. Students will develop skills that will allow them to succeed in academic and professional settings.
3. Students will learn about the different disciplines of their majors.
4. Students will learn how to set and achieve long-term goals.

Expectations:

· Students are required to respect each other. 

· Teamwork and peer interaction/encouragement are expected.

· Students should participate in class discussion and exercises.

· Journals will be regularly assigned. Students must carry out journal exercises when assigned.

· Students will receive the book, The Boy Who Harnessed the Wind, at the beginning of class, and regular reading of the book is required since some class discussions will be based on the content of the book.

Week 1: Building a community
Students will learn the importance of building a community.  Students will participate in team building exercises and will be encouraged to develop attitudes that will foster success amongst peers.
Week 2: Academic development
Students will work on developing skills to help them succeed within the classroom. Students will brainstorm various study skills. Further, students will learn how to talk with professors and about the various campus resources available at their university.

Week 3: Professional development
Students will learn how to create a resume and develop interviewing skills. Students will learn specifics about the disciplines in engineering and agriculture, and more importantly how engineering and agriculture overlap.  

Week 4: Long-term goal setting
Students will develop long-term goals and explore methods of working toward those goals. Further, students will also learn how to improve intrapersonal relationships.
Computer Lab

Course Description: Students will follow the instructor on exercises to help them learn various computer programs. Students will be introduced to programs to help them improve their ability to use a mouse and keyboard. They will be introduced to OpenOffice programs that will allow them to communicate and present their ideas more efficiently and effectively. Then students will learn a drafting program to assist when developing engineering and agriculture designs. Finally, students will begin to learn the basics of programming and using the Internet

Learning Objective: To learn how to the use of computers and computer’s ability to simplify tasks of importance to engineers and agriculturalists. 

Important concepts: Computer, Internet, hardware, software, word processor, spreadsheet, network, typing, programming

Expectations

· Students are expected to show up on time.  The instructors will not wait or help students catch up who show up late for computer labs. 

· All students should keep up with their files and ensure they do not lose the data as the work will build on previous labs.

· Students are expected to ask for help during class from the instructor and the assistant.  Do not ask from help from your fellow students, this slows down the whole class and disturbs others.

· Students should take advantage of help time after lectures.

Week 1 – Introduction to computers and office programs.

Students will learn the basics of the computers and the history. Further, students will practice with the mouse using MS Paint. Finally, students will be introduced to the basic office programs using OpenOffice.

Week 2 – Introduction to drafting and further practice with office programs.

Students will begin to learn Google Sketchup. Further students will practice typing and practice with the office programs.

Week 3 -  Computer practice

Students will refine their computer skills and further practice using the office programs as well as Google Skethup.



Week  4 -  Internet and introduction to programming.

The final week students will learn the basics of the internet and basic programming.  Further, the final week will be devoted to helping the students write their final lab reports and develop their final presentations.
Supplemental Material
Applications Lab -Engineering 
Estimation and Measurement
In this lab each team will put into practice their knowledge of estimation.  Further, they will test their estimates by taking measurements of the desired values.  Data will be collected by hand and should be kept for other activities through out the different sessions of this program.

Instructions

1. Estimating Distance:

a. Locate the two cones placed on the ground by the instructor

b. As a team estimate the distance between the two cones

c. Using a tape measure determine the distance between the cones

d. Repeat parts a-c for all sets of cones indicated by the instructor

2. Estimating Volume:

a. Look at the water provided for you in a basin

b. As a team estimate the volume of water in the basin

c. Using a funnel and the measurement tanks provided measure the amount of water provided

3. Estimating height

a. Using the sighting skills shown during lecture estimate the height of the building indicated by the instructor

b. Repeat for all buildings/structures your instructor assigns

c. Obtain the actual measurements from your instructor

Report

No report is due for this lab.  However, you should keep your data as a team in a safe place.  Your data will be needed during computer skills sessions.

Working with Tools

In this lab each team will learn how to properly use personal protective equipment (PPE) as well as power and hand tools.  You will learn to utilize the tools safely and to pair the right tool with the right job.  Each team will have a chance to use the tools presented by the instructor.

Instructions

1. Obtain protective gear:

a. All members of the team should receive safety glasses, ear plugs and safety gloves

b. The instructor will have a short presentation on the appropriate use of the personal protective equipment (PPE)

c. You are to mark your PPE with your initials and do not loose them

2. Hand tools:

a. The instructor will give each team a set of hand tools

b. This set of tools will be yours for the remainder of the program.  DO NOT LOSE, LEND or BORROW your tools or other teams tools

c. Mark your tools with your team number and team name

d. Each team is to return the tools at the end of the program

e. The instructor will provide a short presentation on the proper and safe use of the tools provided

3. Power tools:

a. Your instructor will give a presentation of the power tools available in the lab.

b. Once the presentation is over each team will be supervised by a teaching assistant and they will prove their safe use of each of the power tools available

Report

No report is due for this lab.  Mark your tools with your team number and name.  Show your tools marked to the instructor and place your tools in the designated area.


Designing

In this lab students will learn the proper paths to designing from an engineering perspective.  Students will learn how to modularize a problem and create a set path towards solving a problem without specific step by step instructions.  

Instructions

1. Listen to the presentation given by your instructor

2. Each team will be given a design problem

3. Brainstorm with your team a proper solution for the problem

4. Using the categories given during your lecture identify the benefits your design brings to each category in solving the problem

5. Identify any gaps your design might have according to the categories given by your instructor

6. Each team will present their design idea and the lists of their pros and cons

Report

No report is due for this lab.  Keep your lists for further brainstorming among your team

Visualizing Vectors and Forces

In this lab students will use simple materials to visualize concepts of vectors and forces.  After the lab the students should be able to perform similar exercises when facing design problems and other more complex concepts.  

Materials

1. String

2. Weights

3. Unpainted Wood pieces

4. Red wood pieces

5. Blue wood pieces

6. Wooden blocks

Instructions

1. Listen to the presentation given by your instructor

2. Using your materials create a representation of the object described by the instructor and the forces acting on it

3. Using your materials create a representation of the vectors that make up the forces in part 2

4. Repeat steps 2-3 for the next representation

Report

No report is due for this lab. 

Bridge Crossing

Problem Statement:

The citizens of a village want to create a bridge that spans the width of a river so they can reach fertile soils on the other side.  The river has a yearly flooding stage in which it floods its banks by 6 feet.  In the river many dangerous animals live, including piranhas and crocodiles.  For the bridge to be successful it needs to be usable all year round and it needs to withstand the weight of all the farmers at once as they cross the river.

Utilizing the materials given, design a bridge for the village.

Materials:

-   You can use all the tools in your tool set and the power tools (power tools are shared among all the groups)

-   1 ½” nails

-   Wood sections 12”x 2”x 1”

-   Tongue depressors

-   Wooden dowels 12” x ¼” diameter

-   Glue

Report:

Each team will be responsible for a report on their design.  The report should follow the formatting used in the Sample Report provided in your handouts.  Make sure you include clearly for this report: the weight of your bridge, the amount of each material used in the bridge and the amount of materials taken from the lab total.  Make sure you also address the main aspects of your design and how they relate to the aspects discussed in class.  

Basket Toss

Problem Statement:

Your bridge was a success.  However, the villagers do not want to cross the bridge with their products after harvest because they are afraid the bridge will not support them and the products.  Further, the villagers are afraid that the mean animals in the river will jump to the bridge to try to steal their products as they cross.

To solve this problem the villagers want a machine that will toss their harvest bundles over the river safe from the teeth of the animals.  Utilizing the materials given, design a machine that will throw the harvests over the river and cause them to land safely at a landing zone.

For this lab you will be given a budget.  You must use your budget to purchase ALL the materials, including any scrap, that you get from the “materials warehouse.”  You may not get more materials once you have spend all your budget.  You are allowed to exchange scrap materials and left over materials among groups.

Materials:

-   You can use all the tools in your tool set and the power tools (power tools are shared among all the groups)

-   Twine

-   1 ½” nails

-   Wood sections 12”x 2”x 1”

-   Tongue depressors

-   Wooden dowels 12” x ¼” diameter

-   Glue

-   Duct Tape

-   Mouse Trap

-   Rubber bands

Report:

Each team will be responsible for a report on their design.  The report should follow the formatting used in the Sample Report provided in your handouts.  Make sure you include clearly for this report: the weight of your machine, the amount of each material used in the bridge and total money spend at the lab.  If you exchanged materials with other groups for different materials or money you should report it as well.  Make sure you also address the main aspects of your design and how they relate to the aspects discussed in class.

Applications Lab - Agriculture 
The Crop Seed

In this lab, students will compare the seed of a dicot crop with that of a monocot crop.

Materials:

-A lab notebook 

-Writing materials

-Magnifying glass 

-Crop seed 

-Petri dishes/plates 

-A pen knife (or any other sharp object that can be used to split a seed) 

-Moisture absorbing or tissue paper

-Garden/top soil-filled 10-15 cm  (4-6 inch) pots.

Procedure:

1. Distribute seed sample of the crops selected to the class (one of each seed and grain per student).

2. Ask students to observe carefully the whole seed and describe what they see in one or two sentences (size, shape, color).

3. Ask students to use the pen knife (or alternative sharp object) provided to carefully split the seed and further describe what they see in one or two sentences.

4. After completing item (3) ask the students to try to answer the following questions:

a. What are the botanical characteristics of the seed/grain of the selected monocot/dicot crop?

b. What are the similarities and differences between the dicot and the monocot seed?

c. What part of the seed stores the food that we eat in the dicot and monocot crop?

5. Draw and label the seed of the dicot and monocot crop showing some or all of the following:

a. Seed coat

b. Cotyledon

c. Scutellum (= cotyledon in monocots)

d. Endosperm (monocot only)

e. Embryo (radicle & plumule)

f. Coleoptile (monocot  only)

g. Coleorhiza (monocot only)

6. Submit lab report

Preparation for next lab:

At the end of the lab session, each student is to plant 5-10 seed each for the dicot and monocot crop in a tissue-paper padded petri plate, add moisture as directed by the Lab Assistant and place in the appropriate position to allow germination. Students are to take note of the conditions for germination. Also plant 2-3 seed in the soil-filled pot to a depth recommended by the Lab Assistant. Each student is to plant 2-3 pots for each of the dicot and monocot crop. Apply water as necessary and place pots in the appropriate environment that allows germination to occur. Students are to take note of the location of the pots that will allow germination to take place.

Seed Germination 

In this lab, students will compare seed germination between a dicot crop and a monocot crop.

Materials: Lab space, lab notebook, a pen, a pencil (with an eraser)
Procedure:

1. Draw a Table with three columns: 

a. Column 1 ”Student #”

b. Column 2 “Dicot seed”

c. Column 3 “Monocot Seed”

Allow as many rows as possible to contain the number of students in the class plus the column Titles. In addition make enough rows for “Total” and “Average”. For example if there are 20 students in the class, the total number of rows should be 20 + 1 (column title) + 1 (Total) + 1 (Average) = 23 rows.

2. Each student is to observe the petri dishes with seed planted in Week 1, and record the number of germinated seed (out of the total number planted).

3. Collect the records of all the students in the class and enter into your Table (the Lab Assistant will help with collecting this information from the whole class)

4. Add the total number of germinated seed and determine the average germination that occurred.

5. From the data collected, answer the following question: What is the percent germination for the dicot and the monocot used in the study?

6. Approximately how many days did it take the seed to germinate?

7. Which of the two crop types germinated first?

8. Draw a diagram of the germinated seed and label to show the following:

a. Plumule

b. Radicle

c. Hypocotyl (dicot only)

d. Epicotyl (dicot only)

e. Tap root (dicot only)

f. Fibrous root (monocot only)

g. Leaf sheath (monocot only)

9. Summarize what you observed in the germination study

10. Submit your lab report

Seedling Growth Habit

In this lab, students will compare seedling growth habit in a dicot crop and a monocot crop.

Materials:

-Lab space

-Pots with crop seedlings

-Writing materials

-Magnifying glass

-Ruler (with metric units preferred)

Procedure:

1. Measure and record the height of the dicot seedling (14 days after planting)

2. Measure and record the height of the monocot seedling (14 days after planting)

3. Count and record the number of fully open leaves in the dicot crop

4. Count and record the number of fully open leaves in the monocot crop

5. Measure the length and breadth of a fully open leaf in the dicot crop

6. Measure the length and breadth of a fully open leaf in the monocot crop

7. Describe the morphology of the leaf of the dicot crop

8. Describe the morphology of the leaf of the monocot crop

9. Carefully uproot a seedling of the dicot crop to observe the root system, wash and rinse carefully with water and spread on a flat clean surface for a good observation (choose a contrasting background to enable you see the roots clearly)

10. Do same as in item (9) for the monocot crop

11. Draw diagrams of the seedlings selected in (9) and (10) and label to show the following:

a. Stem

b. Leaf

c. Apical bud (dicot only)

d. Parallel veins (monocot only)

e. Netted/reticulate veins (dicot only)

f. Tap root (dicot only)

g. Fibrous root (monocot only)

12. Summarize what you observed for the dicot and monocot crops

13. Submit your lab report.

Early Vegetative Growth

In this lab, students will compare early vegetative growth pattern in a dicot and a monocot crop.

Materials:

-Lab space

-Pots with crop seedlings

-Writing materials

-Magnifying glass

-Ruler (with metric units preferred)

Procedure:

1. Measure and record the height of the dicot seedling (21 days after planting)

2. Measure and record the height of the monocot seedling (21 days after planting)

3. Count and record total number of fully open leaves in the dicot crop

4. Count and record total number of fully open leaves in the monocot crop

5. Measure the length and breadth of a fully open leaf in the dicot crop (# 3 leaf counting from the youngest leaf at the top)

6. Measure the length and breadth of a fully open leaf in the monocot crop (# 3 leaf counting from the youngest leaf at the top)

7. Count the number of branches in the dicot crop

8. Count the number of tillers (if any) in the monocot crop

9. Carefully uproot a stand of the dicot crop to observe the root system, wash and rinse carefully with water. Then separate the plant into Shoot and Root, take the fresh weight of weigh each part separately

10. Do same as in item (11) for the monocot crop

11. Dry the harvested plants in an oven at for 72 hours and take the dry weight

12. Draw two Tables, one for fresh weight and one for dry weight, to record all the data collected by the entire class for the dicot and monocot crops. The Table should look like the one below:

	Student #
	Fresh weight (g)/ Dry Weight (g)

	
	Dicot
	Monocot

	
	Shoot
	Root
	Total
	Shoot
	Root
	Total

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	Total
	
	
	
	
	
	

	Average
	
	
	
	
	
	


13. Record the fresh and dry weights in your notebook and estimate the percent dry weights in the shoot and root.

14. From the data showed in the two tables, estimate dry weight as percent of fresh weight for the dicot and monocot crop.

15. Which of the two crops has a higher dry matter content?

16. What is the relative distribution of dry matter between the shoot and the root in the dicot and monocot crops?

17. Summarize what you observed for the dicot and monocot crops

18. Submit your lab report in writing.

19. Present your lab findings to your group of classmates and to the instructor.

20. Be sure to keep a log book of any/all words you did not understand (e.g. dicot/monocot, ‘dry matter’) and write a definition of these scientific words.

21. After each lab study, new questions usually arise. Write down 3 questions about botany, plant science that now perks your curiosity as a result of this lab.

Oil Press Experiment
Oil is a very common and important food source.  The fats contained in oil are necessary for good nourishment of the body.

How is palm kernel oil produced?  

Discuss with your group and list the steps in the space below:

Think about it: 

Which parts of this process are most difficult and why?
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____________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________

One job for engineers, especially mechanical engineers, is to take tasks that are difficult or time consuming, and find ways to make them easier.  Machines, such as an oil press, or an oil expeller, can help us do our worker easier and quicker than by other methods. You can see that we feed seeds in the top, and two products come out.  One is oil, the other is called the “press cake.”  
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Now use your imagination.  How does this machine work?  How can it take the seeds and change them into oil and press cake simply by turning the crank?  What is going on inside?  Take a few minutes and draw what you think the inside of this machine looks like.  When you finish, share your drawing with a neighbor and compare.
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Let’s take this machine apart and see what’s really going on inside.  Ask an instructor to help you get started.  Inspect each component and figure out its purpose.  Each component is designed for a purpose!  This process of taking a machine apart to understand how it works is called reverse engineering.  Reverse engineering is very helpful for inspiration.  You can reverse engineer anything - even nature!  For example, how did someone find out that oil can come from the palm kernel?  They took one apart!
We see that the press produces oil, which is good for food.  What do we do with the press cake?  Come up with some creative ideas and write them below:

Discuss your ideas with your classmates.  Ask an instructor to review your list and suggest any other ideas.  Write different ideas from your class and teachers below:
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This is a concept under the umbrella of sustainability: finding ways to use everything we produce, even if it looks like waste.  Even though the main goal was to squeeze oil out of the palm kernel, our efforts produced the press cake also.  The basic options are to pile it in a corner somewhere, or put it to good use.  The former option gives us nothing but a pile we don’t know what to do with; the later allows us to use creative energy to make something out of nothing.

Extended Activity:

What is the purpose of the flame?  

__________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________
 - Math activity: calculate the percent by weight of oil produced compared with the initial weight of the seed fed into the press.  This is “percent extraction efficiency.”  Higher extraction efficiency means you get more oil for every turn of the crank. 

Water (Collection - Rain & Ground)

Objective:

· Students will learn about the water cycle and how water can evaporate

· Students will then understand how this water evaporation can be collected as a water source

· Students will learn how water can become a source of energy

· To illustrate how water is stored in an aquifer

· Show how groundwater can become contaminated, and how this contamination ends up in the drinking water well.

· Students should get a clear understanding of what happens above the ground can potentially end up in the drinking water below the ground.

The Water Cycle (Rain)
We know that water can be a liquid, a gas, or a solid. Outside, water is always changing from liquid to gas and back again. This process is called the water cycle. You can see how the water cycle works.

The sun's heat causes water to evaporate from streams, lakes, rivers, and oceans. The water vapor rises. When it reaches cooler air, it condenses to form clouds. When the clouds are full of water, or saturated, they release some of the water as rain.
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 U.S. Geological Survey, Wikimedia Commons,

 http://commons.wikimedia.org/wiki/File:Water_cycle.png
Water Cycle Experiment
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Reference: “Make a Mini Water Cycle,” The Water Project, http://thewaterproject.org/resources/lesson-plans/create-a-mini-water-cycle.php, Copyright 2012 The Water Project Inc., All Rights Reserved. 
Groundwater
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 Excerpt from: “Build Your Own Aquifer”, Louisiana Department of Environmental Quality, http://www.deq.louisiana.gov/portal/Default.aspx?tabid=1966)
Many communities obtain their drinking water from underground sources called aquifers. Water suppliers or utility officials drill wells through soil and rock into aquifers for the groundwater contained therein to supply the public with drinking water. Home-owners who cannot obtain their drinking water from a public water supply, will have their own private wells drilled on their property to tap this supply. Unfortunately, the groundwater can become contaminated by harmful chemicals, including improper disposal of household chemicals such as lawn care products and cleaners and any number of other pollutants. These chemicals can percolate down through the soil and rock and into the aquifer - and eventually the well. Such contamination can pose a significant threat to human health. The measures that must be taken by well owners and operators to either protects or clean up contaminated aquifers is quite costly.
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Aquifer Experiment
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Reference: “Build Your Own Aquifer”, http://www.deq.louisiana.gov/portal/Default.aspx?tabid=1966, Copyright 2012 Louisiana Department of Environmental Quality, All Rights Reserved. 
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 Water & Energy  
[image: image21.png]


 (Excerpt from: “Renewable Energy Activities - Choices for Tomorrow”, National Renewable Energy Laboratory, 2001, http://www.nrel.gov/docs/gen/fy01/30927.pdf)
When water is collected behind dams on large rivers, it provides a source of energy for the production of electricity. The enormous power of falling water is capable of turning giant turbines. These turbines drive the generators, which produce electricity. The degree of power is determined by the amount of water and the distance it falls. Hydroelectric power plants do not cause pollution, but there are fewer and fewer places to build dams. The environmental problem arises because a dam is typically built on a river creating a lake where land once stood. Water is a renewable energy source.

Water (Purification & Distribution)

Objective:

* Students understand the process of condensation and evaporation in the purification of water

* Students understand how and why solar energy can also be used to purify water

* Students are able to understand and develop effective water distribution strategies

*Students will learn civil engineering, engineering design, planning, construction, teamwork, and working in groups.

*Operationally define irrigation, while observing and classifying irrigation systems.

*Infer the need for irrigation systems & describe the different types.
*Construct a model and identify the model by observing the characteristics
Water Purification Experiment
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Reference: “Water Purification Experiment”, http://learningtogive.org/lessons/unit389/lesson2.html. Copyright 2012 LearningtoGive.org. All rights reserved. Permission is granted to freely use this information for nonprofit, noncommercial, educational purposes only. 
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Materials:
*Large Strainer

*Coffee Filter

* ½ inch layer of sand 
* 1 Inch of topsoil

*Clear glass for water

Directions

1. Line a medium-size strainer with a coffee filter. Add a 1/2 inch layer of sand and an inch of topsoil. Put the strainer over a clear jar. Tell the students that this demonstration represents the natural water treatment process. This is how nature treats storm water flowing over a natural area with healthy drainage. Stir 2 tablespoons of dirt into a cup of water, then pour the dirty water through the sand and soil in the filter. Ask the students to observe the water in the bottom of the container and the condition of the sand and soil.

2. How does the water look different after it goes through the ground filter?

3. What other kinds of dirt or waste do you think this filter system will clean up? Try some of their proposals, if possible.

Questions:

What kinds of pollution do you think might not be filtered out by this natural process? 

______________________________________________________________________________

______________________________________________________________________________

Would you drink the water if it was polluted with chemicals, detergents and fertilizers? 

(The sand and soil might not be able to clean the water.)

______________________________________________________________________________

______________________________________________________________________________

The Earth is a closed system—no water is ever added to the system over time, and we share the water with everyone in the world. For that reason, we need to be responsible with the water we use. Look at a glass of filtered water. The H2O molecules of water in this glass may have fallen on the heads of dinosaurs, washed the hands of Civil War soldiers, satisfied the thirst of Olympic athletes or flowed down the Amazon River along with the crocodiles.

How can this be?
______________________________________________________________________________

______________________________________________________________________________

Polluted water affects us all now and in the future because water is a common resource we share with all people and animals. What we do locally ends up in the global water system. Water is never created; it is recycled and shared repeatedly.  Water is a common resource and its quality must be sustained for the common good.

Water Distribution Experiment
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Reference: Lesson Focus, Lesson Synopsis, Student Worksheet including Ethical Implications and Design Your Own Irrigation Systems, http://www.tryengineering.org/lessons/irrigationideas.pdf. Copyright 2012 IEEE, All rights reserved. 
[image: image24.png]


Reference: The Different Irrigation Systems and Their Uses, http://www.crwcd.org/page_144, Copyright 2012 Colorado River Water Conservation District, All rights reserved. 
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Life Skills
 Disciplines in Engineering

· Society’s Problems/Needs
· Disciplines of Engineering
· Meet the Disciplines Worksheet
· Identify the Problem and Assign Engineers
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Word Bank

Fill in the blanks below

	Construction
	Electrical engineer

	Electrical/computer engineering
	Computer engineering

	Geology
	Demanding

	Mineral deposits
	Biology and medicine

	Civil
	Environment

	Diverse




Society’s Problems/Needs

Societies face a variety of problems that need to be addressed. One community may have issues that range from harvesting their crops to communicating with the nearby town. Just as in the physical sciences, where there are various disciplines for the wide range of specialties (a physicist may have a hard time doing the work of a biologist), engineering is also divided into many subjects. Having various groups of engineers that specialize in a certain field makes addressing the problems we face much easier to solve, since each group can focus on a specific problem, instead of everyone trying to spread their resources across all the problems. 

For example, a community may be helped by one type of engineer to address their crop-harvesting issues, and another type of engineer to help them communicate with the nearby town. Other issues that can be addressed by engineers are:

· Accessing clean water

· Building a bridge

· Telecommunication

· Energy solutions

· Food shortages

· Better medical equipment

· Recycling and reusing materials

· Planning the layout of a city

· Waste management

· Transportation

· Treating of diseases

· Designing a building

As you can see, the fields where engineers are needed is very _____________________ and ___________________, and that is why we need a variety of different types of engineers. Let’s take a look at the main disciplines of engineering and see how they each contribute to society. 
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Engineering Disciplines

__________________/________________ Engineering: 

As an ______________________ _______________________, you could develop components for some of the most fun devices (MP3 players, digital cameras, or roller coasters) as well as the most essential to life (medical tests or communications systems). The largest field of engineering encompasses the macro (huge power grids that light up cities, for example) as well as the micro (including a device smaller than a millimeter that tells a car’s airbags when to inflate).  As an electrical engineer, you might work on robotics, computer networks, wireless communications, or medical imaging—areas that are at the very forefront of technological innovation (Fig. 1). ___________________ _____________________, a sub-field of electrical engineering, is the design, construction, implementation, and maintenance of computers and computer-controlled equipment for the benefit of humankind.
______________  Engineering: 
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What would it feel like to have the expertise to build a school that could withstand an earthquake, a road system that puts an end to chronic traffic jams, or a sports stadium that offers everyone a great view? As a civil engineer, your job would be to oversee the ​​​​​​​​​​​​​​_________________________ of the buildings and infrastructure that make up our world: highways, skyscrapers, railways, bridges, and water reservoirs, as well as some of the most spectacular and high-profile of all engineering feats—think of the world’s tallest building, the towering Taipei 101 in Asia, or the Chunnel, the 31-mile-long tunnel beneath the English Channel. Civil engineers are fond of saying that it’s architects who put designs on paper, but engineers who actually get things built. 
Geological and Geophysical Engineering:

Geological and Geophysical Engineers draw on the science of ___________________ to study the earth, using engineering principles to seek and develop deposits of natural resources and design foundations for large buildings, bridges, and other structures. (Related engineering fields include Civil, Mineral, Mining, and Petroleum.)

Mining Engineering:
Mining engineers study all phases of extracting ___________________ ___________________ from the earth. They design mines and related equipment and supervise their construction and operation. They also work to minimize the environmental effects of mining. These engineers supply energy and rare materials to meet the world's needs.
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Agricultural and Biological Engineering:
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Agricultural engineers apply knowledge of engineering technology and science to agriculture and the efficient use of biological resources. In addition to creating advances in farming and agriculture, agricultural engineers apply engineering design and analysis to protecting natural resources, develop power systems to support agriculture, and provide environmental controls.

Mechanical Engineering: 

As a mechanical engineer, you might develop a bike lock or an aircraft carrier, a child’s toy or a hybrid car engine, a wheelchair or a sailboat—in other words, just about anything you can think of that involves a mechanical process, whether it’s a cool, cutting-edge product or a life-saving medical device. Mechanical engineers are often referred to as the general practitioners of the engineering profession, since they work in nearly every area of technology, from aerospace and automotive to computers and biotechnology.

Chemical Engineering:

Everything around us is made of chemicals. Chemical changes can be used to produce all kinds of useful products. Chemical Engineers discover and manufacture better plastics, paints, fuels, fibers, medicines, fertilizers, semiconductors, paper, and all other kinds of chemicals.  Chemical Engineers also play an important role in protecting the environment, inventing cleaner technologies, calculating environmental impacts, and studying the fate of chemicals in the environment.

Environmental Engineering:

Environmental Engineering is the study of ways to protect the _____________________.

Most of us care deeply about stopping pollution and protecting our natural resources.  Imagine yourself having more than just a passion for saving our environment, but also possessing the actual know-how to do something about these alarming problems!  As an environmental engineer, you’ll make a real difference in the survival of our planet by finding ways of cleaning up our oceans, rivers, and drinking water, developing air pollution equipment, designing more effective recycling systems, or discovering safe ways to dispose of toxic waste.

Bioengineering/Biomedical Engineering:

Bioengineers study living systems and apply that knowledge to solve various problems. They study the safety of food supplies, keep desirable organisms alive in fermentation processes, and design biologically based sensors. Bioengineering is widely used to destroy wastes and clean up contaminated soil and water. These engineers contribute greatly to human health and the environment.
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Biomedical Engineers study _____________________ and ______________________ to develop technologies related to health care. They develop medical diagnostic machines, medical instruments, artificial organs, joint replacement parts, and prosthetic devices. Rapid advances in these areas will probably continue throughout your lifetime.

Materials Engineering:

Materials Engineers solve problems by relying on their creative and technical skills - making useful products in many forms from common as well as exotic materials. Every day we use a multitude of these products. Each time we talk on the phone, use a computer, or heat food in a microwave oven, we are using products made possible by the inventions and designs of engineers working with ceramics and other materials.

Aerospace Engineering: 

Aerospace engineers design, analyze, model, simulate, and test aircraft, spacecraft, satellites, missiles, and rockets. Aerospace technology also extends to many other applications of objects moving within gases or liquids. Examples are golf balls, high-speed trains, hydrofoil ships, or tall buildings in the wind.

As an aerospace engineer, you might work on the Orion space mission, which plans on putting astronauts back on the moon by 2020. Or, you might be involved in developing a new generation of space telescopes, the source of some of our most significant cosmological discoveries. But outer space is just one of many realms to explore as an aerospace engineer. You might develop commercial airliners, military jets, or helicopters for our airways. And getting even more down-to-earth, you could design the latest ground and sea transportation, including high-speed trains, racing cars, or deep-sea vessels that explore life at the bottom of the ocean. 

Nuclear Engineering: 
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Finally, nuclear engineers harness the power of the atom to benefit humankind. They search for efficient ways to capture and put to beneficial use those tiny natural bursts of energy resulting from sub-atomic particles that break apart molecules. As a nuclear engineer, you may be challenged by problems in consumer and industrial power, space exploration, water supply, food supply, environment and pollution, health, and transportation. Participation in these broad areas may carry you into many exciting and challenging careers. These may include interaction of radiation with matter, radiation measurements, radioisotope production and use, reactor engineering, and fusion reactors and materials.

University of Liberia:

· Civil engineering

· Mining engineering

· Electrical engineering 

· Geology

Class Activity: Meet the Disciplines Worksheet

Now that you have an introduction to the various disciplines of engineering, let us see if you can identify which ones would do certain jobs. To help you, you can use the flashcards provided for you at the end of this section. These flashcards have pictures to help identify what each discipline of engineering does. Take a look through them and see if you can point out the different things these specific engineers can create. 

Once you have gone through the flashcards, work through the “Meet the Disciplines” worksheet at the end of this section. This worksheet is meant to help you guys identify the roles of the engineering disciplines, and how each one would be applied to certain situations. Go ahead and work on them together in your group, and see who can fill them out the fastest. The first 2 groups to get them completed with 3 or less wrong will get a prize!

Class Activity: Identify Problems and Assign Engineers

We have already mentioned a variety of problems that society faces, as seen in the following list in your handbook, as well as up on the board. Can you identify what the particular problem is? What engineers may be useful for solving these problems? Try filling out the following table and write down both the issue and the engineering disciplines that may be most useful. 

· Accessing clean water

· Building a bridge

· Telecommunication

· Energy solutions

· Food shortages

· Better medical equipment

· Recycling and reusing materials

· Planning the layout of a city

· Waste management

· Transportation

· Treating of diseases

· Designing a building

Keep in mind, there definitely is not one right answer, and in fact almost every process would require at least a few different types of engineers.

Finally, can you identify 2 issues you face here in Liberia? What is the problem and what type of engineers would it take to solve it? 

Identify Problems and Assign Engineers  
	Task
	Issue/Problem
	Disciplines of Engineering

	Accessing clean water
	Contamination

Disease

Famine
	Chemical

Agricultural

Environmental

	Building a bridge
	
	

	Telecommunication
	
	

	Energy solutions
	
	

	Food shortage
	
	

	Better medical equipment
	
	

	Recycling and reusing materials
	
	

	Planning the layout of a city
	
	

	Waste management
	
	

	Transportation
	
	

	Treating of diseases
	
	

	Designing a Spaceship
	
	

	Building a Mine

	
	

	Problem #1:

	
	

	Problem #2:

	
	


Meet the Disciplines Flashcards
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Reference: eGFI cards for types of engineering. Copyright 2012 American Society for Engineering Education, All Rights Reserved. Workshop is accessible at: http://teachers.egfi-k12.org/wp-content/uploads/2010/12/cards-worksheet-elementary-school.pdf. Images for matching professions are accessible at: http://www.egfi-k12.org/engineer-your-path/on-the-job/. 

Disciplines in Agriculture

Agriculture is more than just growing plants.  Agriculture can be broadly divided into seven different disciplines. 

· Agribusiness systems

· Animal systems

· Environmental Service Systems

· Food Products and Processing Systems

· Natural Resource Systems

· Plant Systems

· Power, Structural and Technical Systems

1. Agribusiness Systems: 
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Excerpt from: Agribusiness Systems, College Foundation, Inc., https://www1.cfnc.org/Plan/For_A_Career/Career_Cluster_Profile/Career_Cluster_Profile.aspx?pid=5caBy284XLk8QAXAP2BPAXYp1S2QQXAP3DPAXXAP3DPAX&screen=1
· Agricultural marketing specialists:  Agricultural marketing specialists assist producers and distributors of agricultural products by providing product promotional services, monitoring and reporting economic conditions and coordinating and channeling information among producers, distributors and buyers

· Agricultural Loan Officer or Insurance agent: Agricultural Loan Officers are the link between farmers and funding agencies. They help farmers plan for upcoming money needs by advising them about available loan opportunities and helping them complete financial records. They also educate farmers about crop insurances.

2. Animal Systems:
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Reference: Animal Systems – Production Animals, Clayton County High School, http://www.claycountyhigh.com/guidance/programstudy/programsofstudy(1).pdf. All rights reserved. 
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Reference: Animal Geneticist, Purdue University, http://www.agriculture.purdue.edu/usda/careers/AnimalGeneticist.html. All rights reserved. 
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Reference: Aquaculturist, Farlex Inc, http://www.thefreedictionary.com/aquaculturist. All rights reserved. 
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Reference: Animal Nutritionist, Purdue University. http://www.agriculture.purdue.edu/usda/careers/animalnutritionist.html. All rights reserved. 
3. Environmental Service Systems:
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Reference: Agriculture, Food, and Natural Resources Career Cluster, Illinois Community College Board, http://iccbdbsrv.iccb.org/programsofstudy/clusters/ag.html.  All Rights Reserved. 
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Reference: Career Pathways: Environmental Service Systems, College Foundation, Inc. https://www1.cfnc.org/Plan/For_A_Career/Career_Cluster_Profile/Career_Cluster_Profile.aspx?pid=n05OeSfzIeV6tFVK1fXAP2FPAXomAXAP3DPAXXAP3DPAX. All rights reserved.
· Toxicologist: Toxicologists study the adverse effects of chemicals on living organisms

· Environmental Compliance Assurance Manager: Environmental Compliance Assurance Managers analyze scientific data, develop environment compliance policies and perform quality control checks

4. Food Products and Processing Systems: 
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Excerpt from: Agribusiness Systems, College Foundation, Inc., https://www1.cfnc.org/Plan/For_A_Career/Career_Cluster_Profile/Career_Cluster_Profile.aspx?pid=5caBy284XLk8QAXAP2BPAXYp1S2QQXAP3DPAXXAP3DPAX&screen=1
· Food Bacteriologist: Food bacteriologists assist in controlling food pathogens by analyzing food and dairy products for contamination with microorganisms, biological toxins, and antibiotic residues

· Food and Drug Inspector: Food and drug inspectors impose federal (national) grading standards on food and drug products for the purpose of ensuring consumer safety and fair pricing

· Food Engineer: Food engineers develop and operate manufacturing, packaging and distribution systems for food products

5. Natural Resource Systems: This discipline works towards development and maintenance of natural resources like forests, wildlife, water bodies, soil etc. The protection and conservation of these natural resources is the challenge faced by people working in this discipline of agriculture. 
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Reference: Soil Scientist, Beyond the Farm: Ag Careers in Science and Technology, FrazierHeiby, Inc. http://agnewsonline.blogspot.com/2013/01/beyond-farm-ag-careers-in-science-and.html.  All rights reserved.
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Reference: Forest Management, College Majors 101, http://www.collegemajors101.com/forestry_major.htm.  All rights reserved.
6. Plant Systems: People who work in the plant systems discipline study plants and their growth, helping producers of food, feed and fiber crops continue to feed a growing population while conserving natural resources and maintaining the environment. Individuals in this pathway also develop ways to improve the nutritional value of crops and the quality of seeds. They use genetic engineering to develop crops resistant to pest and drought. 
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Reference: Under the Microscope: Plant Breeders, page 43, Biotechnology Jobs in California, Employment Development Department State of California, June 2004, http://biotechsystem.ucdavis.edu/PDFs/Careers/biotech-part2.pdf. All Rights Reserved.
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Reference: Plant Pathologist, Georgia Agriculture Education. http://www.gaaged.org/Careers_in_Agriculture/definitions/_Plant_Pathologist.htm, All Rights Reserved.

7. Power, Structural, and Technical Systems: This discipline applies the knowledge of engineering, hydraulics, pneumatics, electronics, power, structure, and controls to the field of agriculture.  They develop canal systems for irrigation, machinery for harvesting and processing of agricultural produce etc. 

· Agricultural Engineer

· Civil Engineer

· Chemical Engineer

I. Cuttington University
Cuttington University in the college of Agriculture and Sustainable development offers the following three majors

· Plant and Soil Science, BS Degree program

· Animal Science and Health, BS Degree program

· Natural Resource Management, BS Degree Program

Activity 1: Team Product

You will work as a team in for this activity. 
· Each member in your team should pick one discipline of agriculture from the seven disciplines introduced in today’s lecture. 

· Each member should pick a different discipline. 

· Now pick one occupation each

· You can pick any occupation you know of if you think it can contribute to the product your team picks

· Complete Worksheet 1

Worksheet 1

	
	Name
	Discipline picked
	Occupation

	Member 1
	
	
	

	Member 2
	
	
	

	Member 3
	
	
	

	Member 4
	
	
	


· Now identify any product which can be produced by the combined efforts of the occupations in your team

· Identify the contributions by each occupation in your team towards the development of your product

· Complete worksheet 2

Worksheet 2

	Team Product:

	
	Occupation
	Contribution

	Member 1
	
	

	Member 2
	
	

	Member 3
	
	

	Member 4
	
	


 Interdependency of Engineering and Agriculture

Introduction

So far, we have learned extensively about both engineering and agriculture by themselves. We know that engineering is the creation of solutions for society’s problems, while agriculture is the cultivation of animals and plants to provide for the community. Each of these fields has their own disciplines – electrical, mining, and mechanical fields for engineering, agriculture has its waste management, food safety, crop and livestock managing, etc. 
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Class Discussion: What do these fields have in common? Are they related to each other at all? Do they actually depend on one another?

Engineering in Agriculture

Tractors

Indeed agriculture and engineering are extremely interdependent, and they rely on each other to thrive and succeed. For example, in the early days, soil on a farm was cultivated and aerated by the use of a horse-drawn plow (Fig. 1a). When farmers noticed that this technique required a lot of time and manpower, they imagined a machine that would require less energy and allow more efficient plowing. The tractor was then invented by engineers in 1868, using a steam engine (Fig. 1b). This was a machine that strikingly increased the efficiency and  production of agriculture, and is a marvelously engineered system. Modern day tractors are able to plough even more land at one time, and are accordingly even more efficient at their task (Fig. 1c). 

Water


The necessity for water in agriculture is obvious, to feed the plants and animals, to run processes through the use of flowing water, and to maintain machinery and the farmers running them. But water is not just available whenever and wherever it is needed, right? Usually, it is either located in rivers, swamps, or provided by the rain. But a lake and or river may not be nearby, and who knows when it might rain next? So how do farmers actually get water to their plants and animals? Let’s discuss this. 

[image: image281.png][®)BY-sa |



Class Discussion: Can you tell us how water has been stored and transported throughout the past in agriculture? Are there ways that are better than others (collecting rainwater vs. transporting from the river)? 
Many people have used engineering skills to figure out how to best provide water to their crops and animals, as well as how to use water for various mechanical processes. For over 2000 years, people have used the energy of flowing water to drive processes in their houses or industries, such as in textile production, through the use of a _____________ (Fig. 2). For farmers that do not rely only on rainwater, ________________ _________________ have been created, which provides water to the animals and crops through an engineered system (Fig. 3a). In such a system, water is transported from a main source and distributed throughout the entire plantation, allowing each plant to access water. One type of irrigation, called “_________ _____________________,” literally “drips” water over each plant (Fig. 3b). This method was engineered because farmers noticed that water was being wasted when sprayed in large amounts, and the plants were not absorbing it all completely. Drip irrigation provides a way to minimize the water expenditure, while maximizing the water absorption by the plants. This is yet another example of how engineering is so essential to the development and advancement in agriculture. 
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Water Purification

During our introduction to agriculture class, we learned about the ____________ __________. Basically, water in lakes and rivers evaporate into the atmosphere, and then precipitate back down as rain, creating the cycle. Ideally, this means that all 100% of the water on the planet is recycled during this process. However, not all of this water is “renewable.” This is because of the contamination that we as humans put into the water; once pollutants are introduced into the water from industrial and agricultural processes, it cannot evaporate in the proper manner. This leads to a net ______________ in the supply of freshwater around the world. 

Water ___________________ may be very relevant to all of us. If we wash our clothes in the river, we are contaminating the rest of the river for anyone down the stream. If someone bathes in the river upstream of us, we are then drinking and bathing in already dirty water. Accordingly, there is an urgent need for purifying water, in order for it to be safe to drink and use in our everyday life, as well as promote its recycling in the water cycle. 

A variety of engineering techniques has been useful for this. Before we go into them, let’s have a class discussion about it. 

Class Discussion: Do you guys know of ways that water is purified? How do you make water safe to drink? 

As we mentioned, there are many ways of purifying water. __________________ is the use of chemicals to kill the bacteria within the water in order to make it safe. This is a form of ______________ engineering. _______________ is a mechanical process where only water molecules can pass through the openings, but larger molecules like dirt and bacteria are left behind. This is a process that draws from principles of __________________ and _________________ engineering. Finally, the third way we talked about was through _________________. This works similar to chlorination, in that it kills the bacteria in the water, but through the use of high temperatures. This is a form of ________________ engineering. 

Class Discussion: Other forms of engineering in agriculture? 

Class Activity: Matching various engineering tools used in agriculture today.

Agriculture in Engineering
It is obvious from our discussion that agriculture depends on engineering, but even though it may not be as obvious, engineering also depends on agriculture. When thinking about the general nature of engineering, it arises from the need to improve and fix problems faced in various industries, including agriculture. For example, when farmers noticed that their crops weren’t getting enough water from just the normal rainfall, they set forth to invent a system that would allow them to provide water not supplied by the rain. Thus, they engineered the irrigation system. If the agricultural problem hadn’t originated for the farmers, there would have been no need for any engineering. This clearly identifies the dependency of engineering on agriculture: without agriculture and its shortcomings, engineering would not be required nor useful to the industry. 

Genetic Engineering

In another example, we can look at the development of ________________________ ____________________ and its dependence on agriculture (Fig. 4). Many areas, like Liberia, that depend on rice as their main source of nutrition, were noticing a common vitamin A deficiency in the diets. A vitamin A deficiency can lead to early blindness, and therefore was a problem that needed to be taken care of efficiently and quickly. This problem was not easily solvable, however; in poorer countries, it would be hard to establish a new diet, or add a rare component, that would increase the amount of vitamin A the citizens would receive. Thus arose a problem for engineering. Luckily, two scientists, Drs. Ingo Potrykus and Peter Beyer, who are genetic engineers, were able to transfer the genes for vitamin A into a strain of rice, thereby making the rice develop a valuable amount of vitamin A when grown. This strain of rice can then be crossbred with various strains from all over the world, allowing virtually all rice farmers access to vitamin A-containing rice. This would serve to be crucial to the countries where rice is the main diet, providing sufficient vitamin A for the citizens, and helping them avoid blindness. 
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From this example, it is evident that a problem faced in agriculture developed the need for an engineered solution. In general, the industry of genetic engineering relies heavily on agriculture, providing solutions to common problems that arise. Another example is the ________________ __________________, _________________-__________________ crops (Fig. 5). An insecticide gene, or gene that causes a natural repulsion to harmful insects, was transferred from a bacterium to cotton plants, so that the cotton plants would naturally resist harmful insect pests. This would prevent the plant from being infected and eventually killed by the pest, and thereby avoid future generations of plants from being infected as well. 

A resistance to insects comes with many benefits for the farmer and the consumer: the reduction in need for insecticide would starkly decrease, consequently lowering the _________________ ______________ of the crop. Also, having a natural resistance to pests will increase the crop’s yield, ultimately leading to much lower purchasing costs for the consumer. It is estimated that the toxicity of the chemicals used to fend off bugs from plants leads to 3 million people being poisoned in the developing world (World Health Organization). Minimizing the use of these chemicals can clearly be beneficial for everyone. 

It is thereby obvious the impact agriculture has on engineering. Engineering would not be necessary, nor possible, if there weren’t problems arising in the agricultural field that needed solutions.

Class Discussion: Controversy of Genetic Engineering
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The field of genetic engineering is very controversial. Can you think of why?

Summary


In summary, the interdependency of engineering and agriculture is highly important, and evident. Agriculture depends on engineering to provide the right equipment and techniques useful to improve the industry and become more efficient. Irrigation systems created by engineers help farmers regulate the supply of water to their crops, without having to depend on rainfall. On the other hand, engineering depends on agriculture to provide problems that require solutions. The field of genetic engineering thrives substantially because of the needs of agriculturalists. In both cases, without one, the other would be severely hindered in its development and progress. 

Word Bank:              
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decrease

pollution

chemical
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chemical
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production costs
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    mining machine

  milking machine          
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cotton picker


        windmill

plow/plough


      greenhouse
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Resources, Economics and Feasibility

Engineering and agriculture are two different fields which are combined to together to obtain results which meet the needs of society.

Can you think of a few basic needs of society (or yourself)?

What are the resources needed to meet these demands?

· Raw materials

· Technology to process raw materials to products as per demand

· Human expertise

What happens if there is a shortage of any of the resources?

· Product cannot be supplied

· Resources have to be bought from external sources to meet demand

· If there is any product produced, price of product increases

Therefore the kind and amount of products produced should meet the consumer demands

Supply and Demand

Demand refers to the quantity of a good that is desired by buyers. 

Supply is defined as the total quantity of a product or service that the marketplace can offer. 

Surplus condition occurs when the quantity of a product supply is greater than the quantity of the product demand

Deficit condition occurs when the quantity of a product supply is less than the quantity of the product demand

Equilibrium occurs when the quantity supplied equals the quantity demanded.  

Value addition

Value addition is to add economic value to a product by changing its current place, time, and form characteristics to characteristics more preferred in the marketplace. 

As a specific example, a more narrow definition would be to economically add value to an agricultural product (such as wheat) by processing it into a product (such as flour) desired by customers (such as bread bakers).

Engineering finds application in adding value to agriculture products. 

What are the benefits of adding value?

· The price of the product increases; i.e. economic value increases

· A more desirable product is made available to the consumers

Activity: Let’s add value

Fill in the following table by identifying any value added final product available in the market, which has been processed from the given agriculture products. Also think about what engineering aspects were involved in the processing of the value added product

	Agriculture Product
	Value added product
	Engineering technology/expertise needed

	Wheat
	Bread
	Machinery to grind wheat, bake bread

	Cassava
	
	

	Rubber
	
	

	Rice
	
	

	Palm kernels
	
	


Feasibility of a proposed plan

What is feasibility?

A plan is said to be feasible if it can be carried out successfully to meet a set of basic requirements.

Example: The basic requirements for an automobile will be to move, carry load and use as less fuel as possible. If a plan proposes a new automobile which can move very fast and carry a lot of load but requires very high cost fuel, it is feasible? 

If you want to go to school faster, which of the following is more feasible? 
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The following questions should be evaluated to determine the feasibility of a proposed production plan

· Resource feasibility

· Are all the raw materials needed for a particular product available? 

· Is the necessary technology for processing available?

· Is human expertise readily available?

· Economic feasibility

· Will the selling price of the product be greater than the cost price

· Will the profits be enough to continue the production of the products?

· Demand feasibility

· Is the product desired by the community?

· How much of the product is desired?

Case Studies

Given below are 4 different case studies in the field of agriculture where sustainability, engineering and feasibility all play a role. As a group, choose and read one case study. Analyze the problem in the case study and find a solution. Then present your case to the other groups. The questions at the end of your case study will guide you to come up with a solution. For your presentation you can follow the order of the questions. Your instructor will clarify any doubts you may have while reading the passages.

Case Study 1: Thongdee’s energy crisis!

Thongdee Nantha owns a farm in the town of Abala in Uganda. He works the farm with his wife and children and produces more than enough for their needs. They have rice fields, a fishpond and a garden.

The main crop is rice, which occupies about two-thirds of the land. The other one third is not cultivated. Ducks and chickens provide eggs and meat for the family and some eggs for sale – they eat the weeds from the rice fields, vegetable waste and leftover food. There are seven different varieties of fish. Rice bran, duck and pig manure, and aquatic weeds from the rice fields are fed to the fish; insect- and fish-eating fish are kept in a separate pond in the corner.

Thongdee also grows trees on the farm, mostly mango, custard apple, banana and papaya. Then there are some cotton plants from which thread is spun and cloth woven for use by the family. Thongdee’s integrated farming techniques with a combined production cycle of rice, fish, ducks and pigs are lucrative and stable. 

But most of Thongdee’s profit goes into buying electricity from the local power plants. What in your opinion could be a solution to Thongdee’s problem? Remember Thongdee is a sustainable farmer!

Answer the questions below to help Thongdee:

1. Describe the situation in your own words (not more than 3 sentences)

2. Proposal

a. What can Thongdee do to overcome his energy crisis?

b. Is this a feasible option? Discuss Resource, Demand and Economic feasibility of the proposed solution

3. Engineering and Agriculture advise 

a. What engineering services are involved in setting up the proposed solution?

b. What type of Engineers will be required to design and setup the proposed solution

c. What agriculture expertise will Thongdee need? 

4. Value addition

a. Does the new system add value to his farm?

b. What are the reasons to your answer in part (a)

5. Other options

a. What alternative ideas can you suggest for Thongdee?

b. Compare your proposed solution to this alternative. Why is your proposed solution better? 

Case Study 2: Jim’s plants need water!

Jim’s farm is entirely dependent on annual rainfall. If rain is consistent, the family will have a steady income and food all year round or else they are forced to survive on their savings during the no rain periods. But Jim no longer wants to be a victim to weather patterns and is looking for advice on how he can improve his farm conditions. Jim has a well on his farm. He had decided to surface irrigate his farm with the well water, but he is not sure if the well water can sustain his farm on a long term basis without drying up. While trying to look for solutions Jim came across an advertisement for a new kind of irrigation system called Drip Irrigation. Can you help Jim decide if adapting this system in his farm will free him of his dependence on rain?  Given below is the advertisement Jim found. 

Drip Irrigate! Save Water!

Buy your Drip irrigation kit now and conserve water to grow more.

Drip irrigation is an improved irrigation system which draws water from a well and sends it directly to the plants through a series of pipes which are pierced with hundreds of small holes, restricting the overall flow of water so that there is reduced waste. Drip irrigation systems are operational for 5-10 years, resulting in more profits for farmers long after the systems have been installed and paid for. With a drip system, upwards of 90 percent of the water is used by the plant, while with surface irrigation this rate drops below 60 percent.

Advantages

· Drip irrigation uses precious water more efficiently - reducing runoff and evaporation and increasing percolation at the plant roots

· Reduces water contact with crop leaves, stems, and fruit, reducing diseases

· Increased yield and quality

· Agricultural chemicals can be applied more efficiently with drip irrigation

Answer the questions below to help Jim:

1. Describe the situation in your own words 

2. Proposal

a. Do you think Jim landed on the right solution to his problem?

b. Is this a feasible option? Discuss Resource, Demand and Economic feasibility of the proposed solution

3. Engineering and Agriculture advise 

a. What engineering services are involved in setting up the proposed solution?

b. What type of Engineers will be required to design and setup the proposed solution

c. What agriculture expertise will Jim need? 

4. Value addition

a. Does the new system add value to his farm?

b. What are the reasons to your answer in part (a)

5. Other options

a. What alternative ideas can you suggest for Jim?

b. Which option is more sustainable?

Case study 3: Milk to Ice cream

Mike has a 1 acre farm land where he keeps 30 cows. A quarter of the farm is used to grow hay and silage to supplement the cows’ diet and feed them in the off-season. Mike rotates the cows daily on pastures seeded in orchard grass, clover and ryegrass. The grazing season usually lasts from April through October. Through the winter, the cows eat from hay rings on the pasture. Mike also collects manure and composts it. Mike’s cows are well fed and well taken care of, and hence give Mike milk to sell and make a profit. Mike owns five mechanized milking machines and also employees to farm helpers.  

As this was a profitable industry, many other such dairy farmers started setting up farms in that area. The demand for milk fell as the number of suppliers grew and Mike was left with lots of milk and no buyers.  

Mike then decided to invest more in his milk and convert it to a different product desired by consumers and which will increase his income. Mike invested in an ice cream machine! Mike bought 2 ice cream machines and two commercial freezers with the help of a loan and setup an ice cream parlor right on his farm. He employed 2 more workers and started creating more than 75 ice cream flavors all summer long. In 2010, Mike’s ice cream parlor produced 25,000 gallons of ice cream. It’s a lot of ice cream, and so is the gross revenue from $9 per gallon wholesale and $21 per gallon retail.

Mike also converted a small part of his farm to a picnic area where customers can enjoy their ice cream and children can see the cows and other farm animals. 

The frozen dairy product is the icing for the farm. Without adding value to his milk, the dairy business wouldn’t have lasted, Mike says.

“To be honest, I thought we could make a living just grazing and milking, but we’re so limited on space and the size of the herd, we couldn’t keep up with the rest of the new farmers,” he says. “I was ready to sell the cows, but thought I would try ice cream. “We’re profitable, but we weren’t always. It’s the ice cream that makes us so.”

Apart from profits Mike’s farm also has environmental benefits. On the pastures, the herd spreads its own manure during daily rotations which keeps the pastures healthy without any chemical fertilizers. Mike also collects manure from the cow sheds and composts it and sells the compost to nearby gardeners. Mike also employees more than two dozen from his community — four full-timers in the ice cream parlor and milking stations, and up to 25 teenagers part time in the summer in the ice cream parlor.

Answer the following questions

1. Describe the situation in your own words 

2. Proposal

a. Do you think Mike landed on the right solution to his problem?

b. Is this a feasible option? Discuss Resource, Demand and Economic feasibility of the proposed solution

3. Engineering and Agriculture advise 

a. What engineering services are involved in setting up the proposed solution?

b. What type of Engineers will be required to design and setup the proposed solution

c. What agriculture expertise will Mike need? 

4. Value addition

a. Does the new system add value to his farm?

b. What are the reasons to your answer in part (a)

5. Other options

a. What alternative ideas can you suggest for Mike?

 Case study 4: Permaculture

Permaculture is a branch of ecological design and engineering which develops self sustaining agricultural systems modeled from natural ecosystems.

In this exercise your team is a group of Permaculturists who are required to design a farm house for a family of 5. The farm should be able to sustain itself by producing the energy needed and using any waste produced. In case an essential commodity should be purchased from an external source, the farm should be able to produce to sustain a barter system. For example, if you need to buy electricity from an external source, the farm should be able to produce enough grains to exchange for the electricity. Remember the farm’s electricity needs will be year round so different types of grains should be produced to maintain a constant flow of electricity. Most importantly the farm should feed the family! 

Farm Land Specifications:

Size of the land for the new farm is 2 acres. The land has two wells which together can irrigate 1 acre by surface irrigation. Water and electricity can be bought from a nearby municipality. There are big markets for food crops around the farm.  

The following questions will guide you in designing your farm:

1. Describe the case in your own words

2. Initial Analysis

a. What the 3 basic requirements for the farm and the family

b. How can these requirements be supplied?

3. Grow it

a. What do you plan to grow on the farm? Remember the family would like to eat a variety of food (Grains, fruits, Vegetables etc). Also remember to have more than one type so that they have food all round the year. (At least 2 types of grains, fruits etc)

b. Which crop will provide to buy commodities which cannot be produced on the farm? Remember to grow more of that crop. 

c. How do you plan to irrigate the land?

d. How do you plan to fertilize the farm and get better yields?

e. What animals do you plan to have on the farm?

4. Produce it

a. What will is the source of energy? 

b. What machinery will the farm need? 

c. What fuel will the machinery run on? (Do you want to grow something more now?)

5. Engineering

a. What type of engineers will you need to construct this farm?

6. Value addition

a. Pick a product of your farm and discuss how you can add value to the product. What are the negative impacts of adding value? (Example: Machines will be required, if machines are needed then more energy will be needed to run the machines)

7. Feasibility

a. Do you think the amount of energy and water available is enough to produce food for the family and sustain the farm?

Resumes

As you prepare to graduate college, what will be on your mind?  Finding a job!  Here are some tips to help you in that pursuit. 

Brainstorm some things you can do while still in college to “boost” your resume?  What things can you do now to help you stand out from other candidates applying for a job?
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Your cover letter and resume are designed to “sell” you as the solution to a hiring manager’s needs.  Do not be shy about your accomplishments - don’t sell yourself short.  So, keep this in mind as you are designing and writing your resume – everything should be tailored to the perspective of the hiring manager “What is it that this hiring manager needs?”  Then craft your resume to describe your relevant skills and experience that would fit for the position.  

What are the two main purposes of writing a cover letter and resume?

1. _________________________________

2. _________________________________
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       Cover Letters

  A cover letter’s purpose may be to apply for a specific job, to 
prospect for a potential opportunity, or to network.  You should 
tailor the language of your cover letter appropriately.

Why do you need to write a cover letter?

First things first – before you send your resume off you need to be sure to write a job tailored cover letter to accompany your resume.  

Not all employers will ask for a cover letter but all applicants should be prepared to send one because this is one more chance to build upon your resume in order to tell potential employers not only what you’ve done in the past, but also what you will do for them in the future.

Your cover letter should follow the basic format of a typical business letter and should address three general issues:

1. ​​​​​​​​​​​​_____________________________________________

2. _____________________________________________

3. _____________________________________________

Format

Use a business letter format and be sure to keep it neat, easy to read, and error free.

Body of Letter

Start by explaining why you are interested in the opportunity.  Use the cover letter as an opportunity to let your personality come through.  

Next, state your objective.  Some people put this on their resume but it is best served in the cover letter so you can save the space on your resume to really sell your skills and abilities.  An objective statement is a concise statement of what you actually want to do.  For example, “to obtain a position in... , where I can use my skills in…". You can use a few lines to describe that specifically, but keep in mind that you should show what you can do for the company more than what the company can do for you. Writing a good objective can be tough; take some time to think about what exactly you are going to write there.

Finally, state by you would be a good candidate for the position/company.  Keep in mind the perspective of the employer – what are they looking for?

Closing

End your cover letter by asking for an interview and by reminding the employer that you will follow up to confirm receipt of your resume. Promising to follow up—and then actually doing so—demonstrates the kind of persistence and follow-through that many employers look for.

Types of Resumes 

Chronological

· Most common type of resume.

· Listed by date in reverse chronological order (most recent first).

· Shows progression towards your career objective through your employment history.

· Best if you have experience in your desired career field.

Functional

· Listed by skills and experience.  Focuses on these as the primary bones of the resume versus employment history.

· Best if you have little to no experience in field.

· Be sure to still list any relevant employment history.
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Blended

· The Blended format generally makes a good impression particularly for college graduates or those with little to no experience in a field. Although it includes a detailed Experience section as in a Chronological Resume, that section is preceded by one or more sections that call the employer's attention to the skills, experience and accomplishments the job seeker wants to emphasize. 


How to format and what information to include in your resume

HEADING

Line 1 - Name - Use bold and a slightly larger font for this as it will help draw attention to this line - you want them to remember your name, right?
Line 2 – Physical Address 
Line 3 - Phone Number (don't forget this or you won't be getting any calls)
Line 4 - Email address (make sure it is professional.  No joethedancemachine@gmail.com” or “letsparty@aol.com”)

In case you have both a permanent and study address, include both, with the dates when you can be contacted at each of them. 

EDUCATION

You should list your education at the top of your resume as it may be your most important asset at this stage in your career.  List education in reverse chronological order, degrees or licenses first, followed by certificates and advanced training. Set degrees apart so they are easily seen. Put in boldface whatever will be most impressive. Include grade-point average from college only if over 3.0. List selected course work if this will help convince the reader of your qualifications for the targeted job.

No degree received yet? If you are working on an uncompleted degree, include the degree and afterwards the expected date of completion: B.S. (expected 200_).

SUMMARY OF ACHIEVEMENTS, SKILLS, AND ABILITIES

This section is key.  It is one of the first things that an employer will read and is your best opportunity to list your attributes and skills. The secret is to use adjectives that paint a picture of your personality and skills. 

EXPERIENCE

Since your actual work experience may be limited or non-existent you need to focus here on your transferable skills. Nobody really expects you to have started a million dollar business if you're still a student. Accountability is an important criterion for what you write in this section. The account should show what you improved, where, by how much, what your responsibilities were. The idea is that when you apply for a job you have to show growth-potential. That is, that you proved some kind of progress from one job to another and that especially at the last one you were so good, you could obviously do something that involves more responsibility - like the job you are applying for now. The overall result should portray you as a leader, a person with initiative and creativity - don't forget you have to convince the reader of your resume that you are the best pick for that job.

List jobs in reverse chronological order. Include military service, internships, and major volunteer roles if desired; because the section is labeled "Experience." It does not mean that you were paid.

ACCOMPLISHMENTS / AWARDS / AFFILIATIONS

List items you should include in this section on your resume: 

________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________
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Awards

If the only awards received were in school, put these under the Education section. Mention what the award was for if you can (or just "for outstanding accomplishment" or "outstanding performance"). This section is almost a must, if you have received awards. If you have received commendations or praise from some very senior source, you could call this section, "Awards and Commendations." In that case, go ahead and quote the source.

Civic/Community Leadership and other Volunteering

This is good to include if the leadership roles or accomplishments are related to the job target and can show skills acquired, for example, a loan officer hoping to become a financial investment counselor who was Financial Manager of a community organization charged with investing its funds. Any Board of Directors membership or "chairmanship" would be good to include.  

Volunteering positions that are not related to the job or leadership positions may still be impressive to a prospective employer to demonstrate your civic mindedness and character.

Publications

Professional Affiliations
REFERENCES

You may put "References available upon request" at the end of your resume. This is a standard close, but is not necessary: It is usually assumed. You can bring a separate sheet of references to the interview, to be given to the employer upon request.

List here individuals you may be able to include as a professional/academic reference:

1. _________________________________________________

2. _________________________________________________

3. _________________________________________________​​​​
	Resume Do’s
	Resume Don’ts

	Be truthful!  Don’t be afraid to brag on your accomplishments but be honest and never stretch the truth.  It may come back to haunt you.


	Avoid items of controversy:

Political affiliations, controversial employers or activities, religious beliefs.  Unless these items are relevant for the position you are applying for (such as a position with a political or religious organization).

	Keep it brief:  No more than one page unless you have over 10-15 years of experience and are applying for a position with significant responsibility.  
	Avoid listing salary requirements

This is best addressed in follow-up dialogue with a prospective employer – not in a resume.

	Make it visually enticing. Simple clean structure. Very easy to read (select a readable font instead of decorative in font size 10-14). Symmetrical. Balanced. Uncrowded. As much white space between sections of writing as possible (minimum of 1 inch margins); sections of writing that are no longer than six lines, and shorter if possible.  Most word processing software programs offer resume templates.

	Do not include personal information.  Some personal information can be relevant to the job to show a skill or interest related to your career (i.e. a hobby of wood carving for a Construction Project Manager).  However, too much personal information may be irrelevant or an interview turn-off (i.e. pastimes of watching TV or gun collecting).  And some personal information should never be included for example your age, height, weight, race, marital status, etc.  When in doubt – leave it out!

	Have uniformity and consistency in the use of italics, capital letters, bullets, boldface, and underlining. For example, if a period is at the end of one job's dates, a period should be at the end of all jobs' dates; if one degree is in boldface, all degrees should be in boldface.

As mentioned above, the résumé’s first impression is most important. 
	Avoid ALL errors. No typographical errors. No spelling errors. No grammar, syntax, or punctuation errors. No errors of any kind.  Have a friend (or two) review your resume before submitting to any employers.  One or more errors on your resume could be the difference between receiving a request for an interview or not.

	List jobs to include a title, the name of the firm, the city and state of the firm, and the years. Jobs earlier in a career can be summarized, or omitted, and extra part-time jobs can be omitted unless the experience is relevant to the job. 
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	Keep it targeted. First you should get clear what your job goal is, what the ideal position or positions would be. Then you should figure out what key skills, areas of expertise or body of experience the employer will be looking for in the candidate. Gear the resume structure and content around this target, proving these key qualifications. If you have no clear goal, take the skills (or knowledge) you most enjoy or would like to use or develop in your next career step and build the resume around those.
	

	Strengths are highlighted / weaknesses de-emphasized. Focus on whatever is strongest and most impressive. Make careful and strategic choices as to how to organize, order, and convey your skills and background. 
	


Mock Resume Exercise:
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Interviewing

In your job hunt, everything leads up to the interview.  Nervous yet?  Let’s review what you need to know before the big day arrives.
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BEFORE THE INTERVIEW

Research the company 

Be sure you have checked out the company’s website and understand the basics of their business.

Review the job advertisement

Make sure you know what the job entails because if anything is unclear, now is the time to ask your questions.

Create a list of questions to ask the interviewer(s)

They can be about the job itself, the company, benefits, work environment, etc.  Be sure to have at least 2-3 questions prepared.  Asking no questions whatsoever leaves the impression that you did not take the time to prepare for the interview in advance.

Practice answering mock interview questions

Even better, think of potential questions the interviewer may ask you and practice answering the questions.

Interview Preparation Exercise:

Often times, interviewers will ask behavioral interview questions in which they are looking for specific examples (or stories) from your past experience.  Keep this in mind as your prepare for your future interviews.  A great way to get ready for an interview is to think of 5-6 specific examples when you have done something well.  Think of each of them as a story.  If you have of 5-6 good stories they can often be adapted to fit many different types of questions an interviewer may ask of you.  Practice telling your stories so you feel comfortable and confident before you get into the interview.  
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Let’s take 5-10 minutes to brainstorm these stories including the STAR for each:

· S ____________ or T_____________.  Describe the situation you were in or the task that you needed to accomplish.

· A____________.  What specific action did you take to address the situation?  Don’t use words like “would”, “should”, or “might”.  Use action words describing what you actually did.

· R____________.  What happened?  How did the event end?  What did you accomplish/?  What did you learn?

· When have you handled a difficult situation or person?

· Situation or Task:

· Action:

· Result:

· How and/or when have you demonstrated leadership?

· Situation or Task:

· Action:

· Result:

· When did you overcome an obstacle in your life?

· Situation or Task:

· Action:

· Result:

· Have you experienced success?

· Situation or Task:

· Action:

· Result:

· Have you experienced failure?   (*remember to keep this positive and indicate what you learned)

· Situation or Task:

· Action:

· Result:

Exercise:

Now pair up in groups of 2.  Take turns each sharing 2 of your “stories”.  For the person listening, check if the storyteller is describing the full STAR and if they are using descriptive, action words.  Provide feedback.

Potential Interview Questions:

1. Describe a situation in which you had to use reference materials to write a research paper. What was the topic? What journals did you read? (research/written communication)
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Give me a specific example of a time when a co-worker or classmate criticized your work in front of others. How did you respond? How has that event shaped the way you communicate with others? (oral communication).

3. Give me a specific example of a time when you sold your supervisor or professor on an idea or concept. How did you proceed? What was the result? (assertiveness)

4. Describe the system you use for keeping track of multiple projects. How do you track your progress so that you can meet deadlines? How do you stay focused? (commitment to task)

5. Tell me about a time when you came up with an innovative solution to a challenge your company or class was facing. What was the challenge? What role did others play? (creativity and imagination)

6. Describe a specific problem you solved for your employer or professor. How did you approach the problem? What role did others play? What was the outcome? (decision making)

7. Describe a time when you got co-workers or classmates who dislike each other to work together. How did you accomplish this? What was the outcome? (teamwork)

8. Tell me about a time when you failed to meet a deadline. What things did you fail to do? What were the repercussions? What did you learn? (time management)

9. Describe a time when you put your needs aside to help a co-worker or classmate understand a task.  How did you assist them? What was the result? (flexibility)

10. Describe two specific goals you set for yourself and how successful you were in meeting them. What factors led to your success in meeting your goals? (goal setting)
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DURING THE INTERVIEW

· Bring extra printed copies of your resume.

· Speak clearly and confidently.  No babbling.

· Never badmouth a boss or company that you have worked for.

· Keep in mind your body language.  What are examples of good and bad body language?_______________________________________________________

· Express a sincere interest in the job and working for the company.

It should go without saying…

Set your social networking profiles to private

It’s true – your potential employers are very likely checking you out on Facebook to make sure that you are going to be a “fit” within their culture.  Make sure there is nothing there to convince them otherwise.  Or even better, set your profile to private.

Don’t be late!

How can you make 100% sure you are on time to your interview?___________________

________________________________________________________________________________________________________________________________________________

Turn your cell phone off

If you bring your cell phone with you it should be turned ______ or on _________.  And, under no circumstances should you text, surf the web, or answer calls during an interview.

Dress appropriately for the job. 

No matter how formal (or not) your attire should be clean, neat, conservative clothing that looks professional.  When in doubt, dress in business attire.

Bring a ________ and _____________ to take notes.

No flirting or excessive joking with anyone you encounter.

Interview Exercise:

We need a student volunteer to participate in a mock interview.  You will need to remember all the points we’ve reviewed so far.  Take notes on what you learn from this exercise:

AFTER THE INTERVIEW

Show that you are still interested.

Whether in a follow-up phone conversation or in a thank you note – make sure they know that you are still interested.  

1. Write thank you notes to each interviewer

While email thank you notes are quick - consider going the extra mile and handwriting thank you notes to send via snail mail.  You want to stand out from other candidates, right?  Just be sure to write them immediately after your interview and get them in the mail.  Receiving a thank you note weeks after the interview is not impressive.

2. Follow-up as appropriate but know when to sit tight

If you haven’t heard anything, reach out to your contact to inquire on the status.  But, listen carefully for cues – do they appreciate your initiative in following up – or do they want you to sit tight and allow them time to make a decision.  If he/she says I’ll call you then respect that and wait to hear from them.  If another week or more passes, consider sending an email.

Accept rejection with grace. 

Don’t ever ______ bridges. 

You never know when another opportunity might open up at the same company.  Or, your interviewer could even recommend an opportunity they know of elsewhere.  

 Professionalism & Ethics

Characteristics of Professionals 

1. Show self respect 

· Strive for excellence in all you do

· Do not view it as just “a job” 

· Ensure a high quality of service 

· Endeavor to prove your value and worth to the organization (do not possess an attitude of “entitlement’)

2. Demonstrate respect for others

· Treat others as you would like to be treated (or better!)

· Show respect to all people (regardless of their position/hierarchy in the organization)

· Respect other’s time, space, property, etc

· Abide by company policies and procedures (even if  you don’t like them)

3. Exhibit behavioral self control

· Be governed by a code of ethics 

· Do not be motivated by personal gain 

· Keep the best interests of the organization in mind

· Demonstrate maturity in your behavior and attitude (no goofing off, gossiping, laziness, jealousy, etc.) 

· Share the glory in success but take personal ownership for your mistakes

Appearance of a Professional 

· Well-groomed and neat 

· Always dressed in proper attire 

· Exhibiting appropriate body language

If you look professional, you are inclined to be and act professional. 
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                   Appearance Do’s
 Appearance Don’ts
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Time Management of Professionals 

· [image: image311.png](D) BY-NC-sA ]



Show up on time (be punctual).  This applies to the beginning of your work day but also for meetings/appointments throughout the day. 

· Leave enough time for traffic 

· Arrive early 

· Call immediately if you can’t make it 

· Make efficient use of resources and time 

· Take notes to get clear direction when given a task 

· Meet all deadlines 

· Be counted on as responsible 

· Be a multi-tasker 

· Set priorities for each day 

· Keep your manager abreast of your daily schedule 

The following are possible way to manage your time and stay organized?  Are these good approaches – TRUE or FALSE?

_________
Maintain a daily schedule/calendar noting all appointment times

_________
Keep a mental checklist of what needs to get done

_________
Ask your roommate to remind you about an important work meeting coming up.

_________
If available, use your company’s email/calendar feature to set reminders for important tasks or events.
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_________
Write down your to-do list and set priority for each item along with a target date for completion.

Professional Etiquette 

Telephone Etiquette: 

· Speak with a clear, pleasant, courteous voice 

· Identify yourself 

· Leave brief, clear messages 

· Return phone calls promptly 

· Keep personal calls to a minimum 

Email Etiquette:

· Do not use ALL CAPS unless absolutely necessary.  IT COMES ACROSS AS IF YOU ARE SCREAMING AT THE RECIPIENT!

· Only press “reply all” if ALL recipients truly need to receive your response.

· Use a standard email “signature” at the bottom of the email to include your name, company and contact information

· Always practice correct grammar and spelling.  (Spell check is your friend!)

Customer Service Etiquette: 

· Make each customer feel their concerns are important and a priority 

· Build sincerity 

· Be pleasant (even if they are not) by using the proper tone of voice 

· Smile and exude confidence 

Courtesy:

· Practice random acts of kindness 

· Go out of your way to help your co-workers (as time permits) 

· Compliment and encourage each other 

· Honor your commitments (no matter how big or small)

Professionalism Check-List: 

What can I do to improve my professional image? _______________________________________________________________________

Are there any changes I need to make in the way I… 


Appear:


Speak:


Behave:

Business Ethics

"Always do right. This will gratify some people and astonish the rest."

- Mark Twain

What is ethics?  How do you define it?

_____________________________________________________________________________________________________________________________________________________________________________________________________________________

Webster’s Dictionary Definition: ethics
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	Part of Speech
	Definition

	Noun
	1. Motivation based on ideas of right and wrong.
2. The philosophical study of moral values and rules. 
3. The science of human duty; the body of rules of duty drawn from this science; a particular system of principles and rules concerting duty, whether true or false; rules of practice in respect to a single class of human actions; as, political or social ethics; medical ethics.



What ethics is NOT:

Always clearly defined – black and white

A matter of feeling (emotions) or religion

Simply following the rules or laws (which may themselves, at times, be unethical)

Merely doing what is socially acceptable; in some situations doing what is socially acceptable may actually contradict good ethics.  Example: Nazi Germany

Why is ethics important in a professional business environment?  What are potential consequences of poor ethical practices?

________________________________________________________________________________________________________________________________________________________________________________________________________________________

What ethics ARE…

For a decision or action to be considered ethical, it should possess the following characteristics:

· Right: morally correct
· Equitable: just and equal
· Good: brings the highest good for all concerned
· Proper: appropriate and acceptable
· Fair:  honest and due
· Just: justice is done
Ethics can be unstructured and abstract.  Why?

· Because it depends on our ____________  ______________.

· Our moral standard depends on our value system.

· Our __________ _____________ depends on the culture in which we were raised and our background and experiences.

· These things differ from person to person – location to location – and therefore ethical practices of people vary.

As a result, two different people approaching the same ethical decision may come to two different solutions.  

For example, in the case of a mining accident where an employee is lost in the mine, all managers would likely cease operations and begin a man hunt for the missing employee.  This costs the company $20,000 US dollars per day for each day that operations are stopped.  After several days, a decision must be made as to whether the manager continues the search or resumes operations.  The manager will make a decision based on his value system and what seems right to him.  A different manager approaching the same situation may make a different decision.

Ethical decisions are voluntary human actions.

· We all have freedom of choice and free will

· No one can claim that they were “forced” or “pressured” into committing an unethical action.

For example, a person cannot escape his personal liability for a crime by saying he was forced to pay a bribe in order to get the contract.

Business Ethics Exercise

As with most ethical decisions, there is a trade off between costs incurred and benefits received.  Review the following examples and discuss as a group what the ethical solution(s) would be.

1. You are a field manager for a large agriculture firm.  You brother’s best friend, Dennis, works on your team.  You’ve known him for many years and he is almost like family.  For a while you’ve noticed Dennis is not pulling his weight on the team.  His production numbers are dropping.  But, he has a good attitude and seems to try hard.  Your company’s annual performance review is coming up and you know from past experience that any employees with low ratings will be pushed hard to improve or possibly face termination of employment.  Your brother would be furious at you if Dennis’ job was in jeopardy because of you.  How do you approach the annual performance review?  Do you give Dennis an honest rating or do you overlook his shortcomings in order to save his job (even if that means another, stronger performing, member of your team may be at risk of losing their job?).  

2. You are interviewing a Mechanical Engineer candidate that recently left employment from a competitor.  If you hire him, the candidate is happy to share with you the design secrets of the competitor’s top selling product.  What do you do?

3. You work in Research and Development for a company that produces organic pesticides.  You just joined the company after graduating college with a Chemical Engineering degree and have been assigned to enhance a current product.  With your recent improvements, the pesticide can be effective after just one application.  However, the Vice President of the marketing department says the product will turn faster if the instructions on the label indicate multiple applications.  A faster turn means more sales and in turn more revenue to the company.  What do you do?

Relationships: Effective Communication and Fostering Valuable Connections
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 Reference: Communication Skills, http://www.pamf.org/teen/abc/buildingblocks/skills.html. Copyright 2012 Palo Alto Medical Foundation, All Rights Reserved. 
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 Reference: Eight Things to do to Practice Better Communication, 
http://www.pamf.org/teen/abc/buildingblocks/eightthings.html. Copyright 2012 Palo Alto Medical Foundation, All Rights Reserved. 


A. Pre-Conversation
On the following chart, rephrase the statement on the left with an “I” statement.

	Instead of saying…
	I should say…

	You always tell me what to do and never let me do what I want to do. 
	

	You never let anyone else go first.
	

	Why do you always ignore me? You never listen when I have anything important to say.
	

	You need to get off my back!
	

	You need to stop insulting me!
	


B. During the Conversation

On the following chart, write down what you think is important to your parent without using yourself in the statement. That is, rephrase each statement to explain your parent’s reasoning without using yourself in the statement.

	Instead of…
	My parent really means…

	He wants me to check in with him every 5 minutes.
	

	He wants me to turn my music down at night.
	

	He is always on my case about doing my homework and getting my chores done.
	


Even if you're wrong, thinking about what's important to them before the conversation will make it easier to listen during the conversation. 

C. Post-Conversation

1. Keep your end of the agreement.
2. Reflect.
Computer Lab

 History of Computers

[image: image65.png]


Reference: History of Computers, http://www.computersciencelab.com/ComputerHistory/History.htm. Copyright 2002 John Kopplin, All rights reserved.
Parts of a Computer

Vacuum Tubes are devices that control electric current through a vacuum (no air) in a sealed container. They are very fragile and bulky. Thousands of theses had to be used in the ENIAC computers in the 1940s, which contributed to its gigantic size.



Figure 2A. Miniature Vacuum Tubes [image: image67.png](<



 by Stefan Riepl, source: http://en.wikipedia.org/wiki/File:Elektronenroehren-auswahl.jpg
Transistors are semiconductor devices (a material that allows electricity to flow through it) used to amplify and switch electronic signals and power. The reason we don’t have 100 foot long computers anymore is because of the invention of the transistor! Since being developed in the 1950s, the transistor is the fundamental building block of modern electronic devices. It was the gateway to make computers miniature. 
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Figure 2B. Transistor [image: image69.png](<



 source: http://commons.wikimedia.org/wiki/File:Transistors.agr.jpg
Integrated Circuit (or micro chip) consists of many complex electrical circuits which have been etched onto tiny chips of semiconductor. They do the “thinking” and calculations that need to be done by a computer.

Central Processing Unit (CPU) is the “brain” of the computer. A CPU’s job is to execute a sequence of stored instructions called a program. These instructions are carried out in the blink of an eye.

Microprocessor incorporates the functions of a CPU on a single integrated circuit. This was another step into making computers and other electrical devices so small

Software is a term used to describe the computer programs and instructions used to tell the hardware what to do.

Computer Programming is the iterative process of writing computer programs (or software). Programming involves testing, analyzing and refining the computer program.


Hard Disk Drive holds all of the computers information


CD Drives use lasers to read (retrieve) data from a CD (just like a walkman)


A computer Monitor displays information in visual form


A mouse is used to select objects on the monitor.


A keyboard is a board used to input data (numbers or letters) into the computer

Hardware is a term used to describe all the physical things on a computer that you can see and touch.

Input Devices are any piece of computer hardware equipment used to provide data. A  mouse and a keyboard are input devices that allow users to provide data to the computer.

An operating system (OS) is a set of software that manages computer hardware resources and provides common services for computer programs. The operating system is a vital component of the system software in a computer system. Application programs require an operating system to function.


Common Operating Systems: Microsoft Windows and Apple’s Macintosh OS X

A computer uses a File System as a way to organize its’ information. Each file has a name used to reference the storage location in the file system. 

Properties of a file show its’ location in the computer or network, the date that it was created or last modified, the size of the file (just like a book, each file has information in it and the amount of information determines the size of the file)

A Computer Network is a collection of computers interconnected by communication channels that allow sharing of resources and information

The Internet is a worldwide collection of computer networks (worldwide web), cooperating with each other to exchange data using a common software standard. Through telephone wires and satellite links, Internet users can share information.
Teachers: From the donated computers, let the students touch and feel the hard drive and the different parts inside the computer.

Exploring the Operating System

Exploring the operating system: File system, Accessories (paint, calculator, notepad), basic functionality like opening and closing programs and windows.

How to manage your files and folders 

To use a computer effectively, the user must learn how to navigate through its files and programs. 

Just like the things that you own, it is nice to know where to find things. Staying organized can be tedious, but after you have made countless amounts of files, stored all over your computer and you have many "New Folder"s, you'll see the point in being organized!

The windows operating system helps to organize files for you by giving you several pre-made folders. One example is the folder called "My Documents." Inside this folder, you will find "My Music", "My Pictures," etc. You can also make your own folders for whatever category you desire.

Double-click your "My Documents" icon on your desktop or in the START menu and you will see all the folders already provided for you.

[image: image70.jpg]My Documents.




Figure 1C. My Documents icon as it appears on the Desktop [image: image71.png]



Most information on a computer can be accessed from the Hard Disk Drive on the Local Disk (C:). If you know the file path (the files to look through to get to a certain file), you can start here.

The section labeled Devices with Removable Storage is an example of an input device.

The section labeled Network Drives is an example of how computers communicate with each other.

To view the File System on the computer, click on the start menu, [image: image72.png]


 >>My Computer
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Figure 2C. Computer Storage Files [image: image74.png]



To open a file, typically the user double clicks on the icon or the file. The following figure shows a typical view of a computer file.
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Figure 3C. Typical View of a Computer File [image: image76.png]



At the top right of each file, there are usually 3 buttons that you can click.

If you are done using the file, click the [image: image77.png]


 to close the file.

To maximize or adjust the view of a file, click [image: image78.png]



To minimize the screen so that the file name only appears in your toolbar, click[image: image79.png]



Using computer programs

Some of the most useful programs on a computer are very basic. These programs include Notepad, Paint, and Calculator. In Notepad, you can type a document.
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Figure 4C. Notepad [image: image81.png]



In Microsoft Paint, you can test your creativity by drawing. See if you can draw animals as well as these people have!
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Figure 5C. Microsoft Paint [image: image83.png]
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Figure 6C. Picture of a Woman drawn using Microsoft Paint 
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 by Lindz Graham, source: http://www.flickr.com/photos/lindzgraham/1296071847/sizes/o/in/photostream/ 
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Figure 7C. Picture of a Man and an Old Woman drawn using Microsoft Paint 
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 by Paulinebalba, source: http://www.flickr.com/photos/paulinebalba/5011990606/sizes/m/in/photostream/ 
You can use this calculator to do basic math.
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Figure 8C. Calculator [image: image89.png]



Writer tutorial

Writer is a word processor, is very similar to Microsoft Office Word, which is used for many people in school and in work to make documents, homework or reports. Writer is a free program; you can do many features to make an impressive report using Writer.

Question: For what purposes can you use Writer:________________________________________________________ _________________________________________________________________________________________________________________
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 Reference: The following tutorial is excerpted from Tutorials for OpenOffice, http://www.tutorialsforopenoffice.org/tutorial/No_Computer_Experience.html.
First, let’s start by creating a new text document:

4. IF on the desktop, click [image: image92.png]


 > All Programs > OpenOffice.org 2.3 > OpenOffice.org Writer.
5. IF you are in OpenOffice.org Writer, click File > New > Text Document. On the Main Menu
Notice that the Main Menu is at the top of the screen. It has the words File, Edit, View etc.

6. In either case, the text document [image: image93.jpg]& Untitled1 - OpenOffice.org Writer



 appears on your screen.

Screen

[image: image94.jpg]



The Screen is where you see things happen. The screen is like a TV screen.

Keyboard

[image: image95.jpg]S eneoeesosan)
=ojooacoouoeee-ms)
) )L U )





7. The Keyboard has keys that can be pressed to make characters (letters, numbers, and symbols) appear on the screen.

8. Press means to touch a key on the keyboard hard enough to cause the character to appear on the screen and then immediately release it.
9. Press the H key now. (An h appears on the screen) Next to the "h" is a flashing vertical line. That flashing line is the Cursor which indicates the place on the page where something will be placed when you press a key. Press the E key, then press the L key and the P key. (The word help appears on the screen)

Space bar
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The Space Bar key is the long key in the middle at the bottom of the keyboard. Press the Space bar key. (The cursor moves one space to the right)
Shift key
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The Shift Key causes letters to be capitalized.

10. Type the word Help by doing the following:

11. Press and hold down the Shift key as you press the H key. Release the Shift key. (The capitalized letter H appears on the screen)

12. Press the E key, then press L, then press P. (the word Help appears on the screen)

Mouse
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The device next to the keyboard is called a Mouse.

13. Rolling the mouse causes the pointer, [image: image99.jpg]


 to move on your screen.

14. Roll the mouse up and down on the mouse pad. Notice that the pointer, [image: image100.jpg]


, moves up or down on your screen as you rolled the mouse up or down.

15. If you roll the mouse off of the mouse pad, pick up the mouse and place it back on to the mouse pad.

16. Roll the mouse to the left and to the right on your desk. Notice that the pointer, [image: image101.jpg]


, moves to the left or to the right on your screen as you rolled the mouse left or right.

17. Roll the mouse so the pointer, [image: image102.jpg]


, is somewhere on the word Help.

18. Without moving the mouse, click with the mouse. (To click, put your right hand on the mouse. The mouse is divided into two or three parts. The parts are called buttons. Put your index finger (the finger that you use to point) on the left button and press the left button with your index finger then release the button.)

19. Notice that the cursor (flashing vertical line) moved to where you clicked the mouse. Press the letter X (an X will appear at the place where the flashing cursor is located)

Optimize the Writer window

You can increase or decrease the size of what you see on the screen

8. Click View > Zoom > Optimal (A dot appears before the word, Optimal) Click OK.

9. “Optimal” can be replaced with other choices.

Name and Save a file

7. Click File > Save As. (The [image: image103.png]Save As



 window appears)

8. In the “Save in:” pull-down menu, select My Documents. (Click on the ▼to open the pull-down menu then select “My Documents)

9. In the “File name:” pull-down menu, type My first file then click Save.

10. [image: image104.png]


 appears at the top of the screen. The file named “My first file” is still opened on your computer and is the OpenOffice text file format. The file is also saved in the “My Documents” folder by the name “My first file”.)

Close a file

11. Click File > Close. (The “My first file” file has been closed)

Open a file

14. Click File > Open. (the [image: image105.png]Open



 window appears)

15. Open the Look in: box by clicking the ▼. Select My Documents. Click on My first file. Click Open.

[image: image106.png]
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 Reference: The following tutorial is excerpt from Tutorials for OpenOffice, http://www.tutorialsforopenoffice.org/tutorial/First_Time_User_OpenOffice_Writer.html.
Toolbars

· The line that starts with the word File is called the Menu Bar. (Clicking on a word in the Menu Bar shows a list of things that you can choose to do in Writer. This list is called a Menu.)

· The second line down is the Standard Toolbar. (Clicking on a small picture will make available a specific function that can be done in Writer.)
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· The third line down is the Formatting Toolbar. (Additional specific functions that can be done in Writer are on this line.)
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· The Horizontal Scroll bar (by clicking and holding the pointer, you can navigate a document left and right) is located at the bottom of the page above the Status Bar which is the line at the bottom of the screen that starts with Page 1/1. (This line gives you information about the document you are presently using.)
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· The Vertical Scroll Bar (by clicking and holding the pointer, you can navigate up and down) is located on the right side of your screen.
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 Reference: The following tutorial is excerpted from Tutorials for OpenOffice, http://www.tutorialsforopenoffice.org/tutorial/First_Time_User_OpenOffice_Writer.html.
Icons, Click, Right-click, Insert

1. The small pictures on the Standard Toolbar and some of the other toolbars are called icons. Click on each icon. (Click means to press and release the button on the left side of the mouse with your index (pointer) finger. Click only one time unless instructed to “double- click”.)

2. Find the Gallery icon, [image: image114.jpg]


. Click on the Gallery icon. (The Gallery window appears on the screen. The background changes color when the icon is in use. Some users may see a white background and some may see a blue background.)

3. Click on the Gallery [image: image115.jpg]


 icon again to close the window. (There is no background color on the “Gallery” icon.)

4. Right-click anywhere on the printed or white page area of this tutorial. (Right-click means to press and release the button on the right side of the mouse with your middle finger. Click only one time unless instructed to double-click. A menu appears on the page. To close the window, click anywhere on the page other than on the menu.)
5. On the Menu Bar, click on Insert. (The “Insert” menu appears. This is a list of the various things you can choose to do in Writer.)

Turn Off the Word Completion Feature

· Click Tools > AutoCorrect > Word Completion tab. (The “AutoCorrect” window appears.)

· Remove the check-mark in the box, if it is there, before the words Enable word completion. Click on the OK button.

Undo Entries

Entries can be undone (can be deleted) in the reverse order in which the entries were made. Word(s), graphic(s), and paragraph(s) can be deleted and "Undo" can be used to put them back in your document. Type the three paragraphs below.

This is the first paragraph.

This is the second paragraph.

This is the third paragraph.

Delete Word(s)

· In the first paragraph, (This is the first paragraph.), click on the beginning of the word, first. Press the delete key. The first letter is deleted, do so until the whole word first, is deleted.

· Click Edit. (You will see the menu below.)
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· Click on Undo: Delete 'first'. (The word, "first", that was deleted is placed back in the document and the menu will close.)

Delete One Paragraph

5. Highlight the first paragraph, This is the first paragraph. Press the Delete key to delete the paragraph. Click Edit. (When you delete one paragraph and you click Edit, you will see the menu below,

[image: image117.jpg]49 Undo: Delete 'This the...agraph.’ Att+Backspace

<G Repeat: Deete Thisthe. agraph




· Click Undo: Delete 'This is ...agraph.' (The paragraph, "This is the first paragraph" is placed back in the document. The length of the sentences in the paragraph determines how much of the paragraph is shown after the "Undo: Delete".)

Delete More Than One Paragraph

· Highlight the three paragraphs (This is the first paragraph. This is the second paragraph. This is the third paragraph.) at the beginning of the section, Undo Entries. Press the delete key to delete the paragraphs. (The three paragraphs are deleted.)

· Click Edit. (You will see the menu below.)
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· Click on the Undo: Delete 'Paragraphs'. (The deleted paragraphs are placed back in the document.)
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 Reference: The following tutorial is excerpted from Tutorials for OpenOffice, http://www.tutorialsforopenoffice.org/tutorial/Pictures_In_Text_Files.odt
Insert an Image (Picture)

· Click Insert > Pictures > From File. (The “Insert picture” window will appear.)
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· Click on Desktop. And select the file named “image.jpg” from the Insert picture window. Click the Open button. The image (picture) appears on your document. There are small green squares called handles at the edges of the image (picture) that indicate the image (picture) can be manipulated.
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· To anchor the image (picture) above or below the text, click Format > Anchor > As Character.
· Insert Image (Picture) In Your Text

Adjust the Height of the Image (Picture)

If the height of the selected item is greater than the current font size, the height of the line containing the item is increased. Adjust the height of the image (picture) so that it has little effect on the text line by resizing the image.

· Click on the image (picture). (An anchor,[image: image125.jpg]


, will appear. Eight points (green squares), called "handles", will appear along the sides of the image [picture].)

· Place your pointer on any of the handles (points). To keep the proportions of the image (picture), press and hold the Shift key. Click and drag a handle of the image (picture) to modify the image (picture). (A double-headed arrow ,.[image: image126.png]


, will appear.) Release the mouse button to complete the resize.

· When you have changed the image (picture) to the desired size, click anywhere on the page except on the image (picture). (The image [picture] will be the desired size.)
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 Reference: The following tutorial is excerpted from Tutorials for OpenOffice, http://www.tutorialsforopenoffice.org/tutorial/First_Time_User_OpenOffice_Writer.html
Delete Graphic(s)

· Click on the picture. (The green handles will appear.)
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· Press the Delete key. (The graphic is no longer on your document.)

· Click Edit. (You will see the menu below.)
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· Click Undo: Delete graphics Alt+Backspace. (The graphic reappears on the document.)
Text Alignment (Left, Centered, Right)
Select the first paragraph by clicking the left button of the mouse and holding the cursor at the beginning of the paragraph, dragging the mouse up to the end of the paragraph and releasing the left button. The text is selected and should look like this:
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1. On the formatting toolbar select Right text orientation button 
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2. The text should go to the right side of the page.
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1. Click Tools > AutoCorrect > Word Completion tab. (The *AutoCorrect’ window appears.)

2. Remove the check-mark inthe box, if it is there, before the words Enable word completion. Click on the
OK button.

Undo Entries

Entries can be undone (can be deleted) in the reverse order in whichthe entries were made. Word(s), graphic(s),
and paragraph(s) can be deleted and "Undo" can be used to put them back in your document. Type the three
paragraphs below.

Thisis the first paragraph.
Thisis the second paragraph.
Thisis the third paragraph.

Delete Word(s)

1. Inthe first paragraph, (This is the first paragraph.), ciick on the beginning of the word, first. Press the
delete key. The firstletter is deleted, do so until the whole word first, is deleted
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'9_amphora_longjumping[L]jpg” was removed from your
Dropbox folder. (click to undelete)

» S




3. Now, let’s center the second paragraph, select again the second paragraph, the text should be highlited
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Undo Entries
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and paragraph(s) can be deleted and "Undo" can be used to put them back in your document. Type the three
paragraphs below.

Thisis the first paragraph.

Thisis the second paragraph.
Thisis the third paragraph.

Delete Word(s)

1. Inthe first paragraph, (This is the first paragraph.), ciick on the beginning of the word, first. Press the
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4. Click the center text orientation button
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5. The text should go to the center of the page.
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1. Click Tools > AutoCorrect > Word Completion tab. (The *AutoCorrect’ window appears.)

2. Remove the check-mark inthe box, if it is there, before the words Enable word completion. Click on the
OK button.

Undo Entries
Entries can be undone (can be deleted) in the reverse order in which the entries were made. Word(s), graphic(s),
and paragraph(s) can be deleted and "Undo" can be used to put them back in your document. Type the three
paragraphs below.
Thisis the first paragraph.
This is the second paragraph.
Thisis the third paragraph.

Delete Word(s)

1. Inthe first paragraph, (This is the first paragraph.), ciick on the beginning of the word, first. Press the
delete key. The firstletter is deleted, do so until the whole word first, is deleted
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Change Text Size

1. Select the second paragraph, should the text should be highlighted

[image: image138.png]S=dio >}

FastStartTeacherManual - Computers.doc [Compatibility Mode] - Microsoft Word (Product Activation Failed)

Wome | Insert  Pagelayout  References  Mailngs  Review  View  Autodesk Vault o
R T A x| Aa | B 4 Fina -
b il TRV NI 20 7 AaBhb AaBbC AaBbCc AaBbCel AaBbCcD AsBoC £, Replace
Paste - -A - [ | THeadingl THeading2 THeading3 THeading4 THeading THeadin Crange | %
D o [B]7 u - ae x x WA OO Heading1 THeading2 THeading3 THeading4 THeading5 T Heading6 Cuemos Serect~

1. Click Tools > AutoCorrect > Word Completion tab. (The *AutoCorrect’ window appears.)

2. Remove the check-mark inthe box, if it is there, before the words Enable word completion. Click on the
OK button.

Undo Entries
Entries can be undone (can be deleted) in the reverse order in which the entries were made. Word(s), graphic(s),
and paragraph(s) can be deleted and "Undo" can be used to put them back in your document. Type the three
paragraphs below.
Thisis the first paragraph.
This is the second paragraph.
Thisis the third paragraph.

Delete Word(s)

1. Inthe first paragraph, (This is the first paragraph.), ciick on the beginning of the word, first. Press the
delete key. The firstletter is deleted, do so until the whole word first, is deleted
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2. Click on the drop-down menu next to the text style the number 12 by clicking on the arrow and select the number 18
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3. The text should look like this (the second paragraph is bigger)
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1. Click Tools > AutoCorrect > Word Completion tab. (The *AutoCorrect’ window appears.)

=

2. Remove the check-mark inthe box, if it is there, before the words Enable word completion. Click on the
OK button.

Undo Entries

Entries can be undone (can be deleted) in the reverse order in whichthe entries were made. Word(s), graphic(s),
and paragraph(s) can be deleted and "Undo" can be used to put them back in your document. Type the three

paragraphs below.
Thisis the first paragraph.
This is the second paragraph.
Thisis the third paragraph.

Delete Word(s)





Open Office Calc Tutorial
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 Reference: The following tutorial is excerpted from Tutorials for OpenOffice, http://www.tutorialsforopenoffice.org/tutorial/Spreadsheet_Basics.html
The Word Spreadsheet

The term spreadsheet was derived from a large piece of paper that accountants used for business finances. The accountant would spread information like costs, payments, taxes, income, etc. out on a single, big, oversized sheet of paper to get a complete financial overview.

Spreadsheets Today

Some examples of spreadsheet usage:

· Spreadsheets act like a calculator by automatically doing calculations.

· Spreadsheets are used for tracking personal investments, budgeting, invoices, inventory tracking, statistical analysis, numerical modeling, address books, telephone books, printing labels, etc.

· Spreadsheets are used in almost every profession to calculate, graph, analyze and store information.

· Spreadsheets are used for What-if calculations. Change one number in a spreadsheet and all the calculations in a large spreadsheet will re-calculate, will automatically change.

Open a Spreadsheet

· IF on the desktop, click [image: image143.png]


 > All Programs > OpenOffice.org 2.3 > OpenOffice.org Calc.
· IF you are in an Open Office program, click File > New > Spreadsheet.
· In either case a spreadsheet called [image: image144.jpg]& Untitled1 - OpenOffice.org Calc



 appears on our screen.

The Calc Toolbars

The following four Calc Toolbars appear at the top of all Calc screens:

Main Menu Toolbar

The first toolbar is the Main Menu toolbar that gives you access to many of the basic commands used in Calc.
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Function Toolbar

The second toolbar down is the Function Toolbar. The Function Toolbar contains icons (pictures) to provide quick access to commands like New, Open, Print, Copy, Paste, etc. When you place your mouse cursor over any of the elements of a toolbar, the name of the element appears on your screen.
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Activity: let the kids move the cursor above the different icons to see what is each of them.

Move your cursor over the icon [image: image147.jpg]m



. (The word “New” appears. Clicking on [image: image148.jpg]m



 opens a new spreadsheet.)

Formatting Toolbar

[image: image149.jpg]FIS78





The third toolbar down is the Formatting Toolbar. The Formatting Toolbar has icons plus drop-down menus that allow you to select a font, font color, alignments, number formats, border options and background colors.
Formula Toolbar
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The fourth toolbar down is the Formula Toolbar. The Formula Toolbar contains the Name Box drop-down menu and a long white box called the Input Line.

Note: If your Toolbars look different, it is because these toolbars are in 800x600 screen resolution and the last eight icons are not shown but are available by clicking on the [image: image151.jpg]


 on the far right of the toolbar.

The Spreadsheet Itself
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The rest of the window contains the spreadsheet. The spreadsheet is divided into rows that have a number at the left of each row and divided into columns with letters at the top of each column.

Cells

A cell is the fundamental element of a worksheet. This is where things are added and where things are seen. A cell address in a spreadsheet identifies the location of the cell in the spreadsheet. A cell address is a combination of the column letter and the row number of a cell, such as A2 or B16.etc. When identifying a cell by its address, the column letter is always listed first followed by the row number. The cell address of the example below is A5.
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Enter Data

· Click on the A1 cell (The cell at the very top left of the spreadsheet).

· Notice the heavy black border around the A1 cell. The heavy black border indicates that A1 is the active cell. (A is at the top of the first column and 1 is on the first row. Both are highlighted. The highlighting also indicates that A1 is the active cell.)
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· Type Hello World and press Enter.

· The active cell is now A2. (The words “Hello World” are in A1.)
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When you type something in a cell and press Enter, what you typed is seen in that cell and the cell below becomes the next active cell.

Delete Data

1. Click on A1 again.

2. Press the Delete key. (The “Delete Contents” window appears.)
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1. Check the Delete all box then click OK. (“Hello World” is deleted from A1)

Format Data

Separate Thousands, Two Decimal Places, Red Negative Numbers

1. Click cell A1. > Type the number -9999.129 > Press Enter. (The cursor moves to cell A2)

2. Right-click cell A1. (A small menu appears) > click Format cells. (The “Format cells” window appears)
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Click Numbers tab. Under “Category”, click on Number. Under “Format”, click on -1,234.12. Click In the small box before “Negative numbers red”. (A check-mark appears in the box) > Click OK. (The number '-9,999.13” appears in cell A1.

Align Left

Click Alignment tab. In the “Horizontal” pull-down menu, select Left. Click OK. (the numbers move to the left edge of the cell.)

[image: image158.png]


[image: image159.png][D)ey |



 Reference: The following tutorial is excerpt from Tutorials for OpenOffice, http://www.tutorialsforopenoffice.org/tutorial/Spreadsheet_Math.html
Addition

The + sign is used for addition. To enter the + sign, press the Shift key and the +, [image: image160.png]


,key.

1. Click on A6.
2. Type the number 10, then press Enter. ("10" appears in "A6" and the active cell is "A7".)

3. Type the number 5, then press Enter. ("5" appears in "A7" and the active cell is "A8".)

4. Type =A6+A7 (Or click the “Function”, [image: image161.jpg]


, icon. The “=” appears in “A8'. The “Function”, [image: image162.jpg]


, icon changes to the “Accept”, [image: image163.jpg]


 , icon. Then type "A6+A7".).

5. Press Enter (or click the “Accept”, [image: image164.jpg]


, icon). The answer, 15, appears in A8.

Sum (Calculate The Total Of A Column)

1. In A1, type 5, press Enter.

2. In A2, type 5, press Enter,

3. In A3, type 5, press Enter,

4. In A4, type 5, press Enter
5. In A5, type 5, press Enter.

6. Click In A6, the last cell in the column of numbers you want to add. ("A6" has a heavy dark border and is the "Active Cell." )
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1. Click on the Sum, Σ, ("Σ" is the mathematics symbol for sum.) icon on the Formula Toolbar just left of the Input Line The Function, [image: image166.jpg]


, icon changes to the Accept, [image: image167.jpg]


, icon.

2. Click the Accept, [image: image168.jpg]


, icon (green check mark) or press Enter. The formula, =SUM(A1:A5), appears in the A6 cell.

3. Press Enter. The sum, 25, will appear in A6. A7 becomes the active cell.
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Cell Range

In the section above, the SUM function appears as =SUM(A1:A5). The A1:A5 in the parenthesis is called a Cell Range. It is shorthand for "from A1 to A5".
Subtraction

The - sign is used for subtraction. To enter the – sign, press the [image: image170.png]


 key.

1. Click on A8. To clear cell A8, press the Delete key. (The “Delete Contents” window appears.) Check the Delete all box and click OK.
2. Type =A6-A7 (Or click the “Function”, [image: image171.jpg]


, icon. The “=” appears in “A8" The “Function”, [image: image172.jpg]


, icon changes to the “Accept”, [image: image173.jpg]


 , icon. Then type "A6-A7".).

3. Press Enter (Or click the “Accept”, [image: image174.jpg]


, icon.) The answer, 20, appears in A8.

Multiplication

The star ,*, sign is used for multiplication. To enter the * sign, press the Shift key and the number 8 [image: image175.png]


 key.

1. Click on A8. To clear cell A8, press the Delete key. (The “Delete Contents” window appears.) Check the Delete all box and click OK.
2. Type =A6*A7 (Or click the “Function”, [image: image176.jpg]


, icon. The “=” appears in “A8”. The “Function”, [image: image177.jpg]


, icon changes to the “Accept”, [image: image178.jpg]


, icon. Then type "A6*A7").

3. Press Enter (Or click the “Accept”, [image: image179.jpg]


, icon.) The answer, 125, appears in A8.

Division

The slash, /, sign is used for division. To enter the slash, /, sign, press the [image: image180.jpg]


key [? And /].

1. Click on A8. To clear cell A8, press the Delete key. (The “Delete Contents” window appears.) Check the Delete all box and click OK.
2. Type =A6/A7 (Or click the “Function”, [image: image181.jpg]


, icon. The “=” appears in “A8'. The “Function”, [image: image182.jpg]


, icon changes to the “Accept”, [image: image183.jpg]


, icon. Then type "A6/A7".).

3. Press Enter (Or click the “Accept”, [image: image184.jpg]


, icon.) The answer, 5, appears in A8.

Average

1. In A1, type 5, press Enter.

2. In A2, type 5, press Enter,

3. In A3, type 5, press Enter,

4. In A4, type 5, press Enter
5. In A5, type 5, press Enter.

6. In A6, type 25, press Enter.

7. In A7, type =Average(A1:A6), press Enter. (8.33 appears in A7)

Enter Formulas

When you type in formulas, the order of operations must be correct. The correct order is: exponentiation, multiplication, division, addition, then subtraction. Let's pretend we want to perform a calculation using the equation:

	x + 10

	y + 20


and suppose we entered it into Calc as follows:

1. Select the A column. (Click on the letter "A." The whole "A "column is selected)

2. Press Delete. (Make sure the "Delete all" box is checked.)

3. Press OK.

4. Click on A1.

5. Type 20 in A1 and press Tab.

6. Type 10 in B1 and press Tab. (Cell C1 becomes active)

7. Type the formula =A1+10/B1 + 20.(Or click the “Function”, [image: image185.jpg]


, icon which changes to the “Accept” [image: image186.jpg]


 icon. Type "A1+10/B1+20").

8. Press Enter (Or click the “Accept”, [image: image187.jpg]


, icon. The answer, 41, appears in C1.)

The answer should be 1, using x = 20 and y = 10, but we got 41 for an answer! Why? Because Calc interpreted the equation as:

20 + (10/10) + 20

which equals 41. If you use formulas with equations in the numerator and denominator, you need to use parenthesis () to force the spreadsheet to calculate them properly. Make the following changes:

1. Click on C1.

2. Click on the Input Line.

3. Edit the formula to read =(A1+10)/(B1+20). (Click just before the A, then Press the ( key [Shift-9]. Click after the 0 in 10, then press the ) key [Shift-0]. Click just before the B, then Press the ( key [Shift-9]. Click after the 0 in 20, then press the ) key [Shift-0]).

4. Click the Accept, [image: image188.jpg]


, icon (green check mark.) The correct answer, 1, appears in C1.

Copy Formulas

You can copy a formula so that the formula itself is copied OR that the answer to the formula is copied.

Copy The Formula Itself

1. Select (click on) the cell(s) that is to be copied.
2. Right-click, then click Copy. (The material is copied to the clipboard)
3. Select (click on) the cell where the material is to appear.
4. Right-click, then click Paste.
Copy The Answer of a Formula

1. Select (click on) the cell(s) that has a formula.
2. Right-click, then click Copy. (The material is copied to the clipboard)
3. Select (click on) the cell where the material is to appear.
4. Right-click, then click Paste Special. (The “Paste Special” window appears)
5. Remove the check mark at Paste all.

6. Remove the check mark at Formulas and add a check mark at Numbers. Click OK.

Exponentiation

The number 102 is written as 10^2. To enter the ^ sign, press the Shift key and the number 6, [image: image189.png]


, key.

1. Click on A9.

2. Type =A6^A7 (Or click the “Function”, [image: image190.jpg]


, icon. The “=” appears in "A9". The “Function”, [image: image191.jpg]


, icon changes to the “Accept”, [image: image192.jpg]


, icon. Then type "A6^A7".).

3. Press Enter (Or click the “Accept”, [image: image193.jpg]


, icon.) The answer, 100000, appears in A8.
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 Reference: The following tutorial is excerpt from Tutorials for OpenOffice. http://www.tutorialsforopenoffice.org/tutorial/Columns.html
Add A Label To Columns

1. Make A1 the active cell. (Click in cell A1)

2. Type Check No then press the Tab key (The cursor moves to B1)

3. Type Paid To then press Tab. (The cursor moves to C1.)

4. Type Description then press Tab.

5. Type Deposit then press Tab.

6. Type Withdrawal then press Tab.

7. Type Balance then press Enter.

Insert An Additional Column

Insert a Date column in the first column.

1. Select column A. (Click on the "A" at the top of the column. The column turns black.)

2. Click Insert > Columns. (The cell contents in columns "A" through "F" shift to the right and becomes columns "B" through "G". Column "A" cells are empty.)

3. Select A1.

4. Type Date then press Enter.

Change The Appearance of Column Labels

Center The Column Labels

Use An Icon From The Formatting Toolbar

1. Select cells A1 through G1 by dragging the mouse from cell A1 to cell G1 (Click on A1 and without releasing the click, move the cursor over B1, C1 etc until the cursor is in cell G1. Release the click)

[image: image196.jpg]FIS78





1. On the Formatting toolbar, click the Align Center Horizontally [image: image197.jpg]


 icon. (The column labels become centered)

Select “Bold” And “Light Blue” For The Column Labels

1. While the cells are still selected, move to the left and click the Bold, [image: image198.jpg]


, icon.

2. Move to the right to the Font Color [image: image199.jpg]>



 icon and pick Light Blue. (At the "Font Color", icon, click and hold the click until a choice of colors appears. Select [click on] the "blue" square). Press Enter.

Make Entries In the Check Register

Enter An Initial Balance:

1. Select A2.
2. Enter a date, 07/12/07. (type 07/12/07)

3. Select G2.
4. Enter 5000.
Format Columns For Currency

The Deposit, Withdrawal and Balance columns will contain dollars with a $ appearing in front of the numbers. All three columns can be formated at the same time.

1. Use Drag to select columns “E” through “G”. Click on E. (The cursor is at the top of column “E”) Press and hold down the left mouse button. Move the mouse pointer to G by moving the mouse. Release the mouse button. (Columns “E”, “F”, and “G” are highlighted)

Continue by using either of the following two methods:

Use A Icon From The Formatting Toolbar

1. Click the Number Format Currency, [image: image200.jpg]


, icon. (The three columns will show the $ when they have numbers in them.)

Use Format From The Main Menu

This method is more complex than using the icon.

1. Select columns E through G.
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1. Click Format > Cells... (The "Format Cells" dialog box appears.)

2. Click the Numbers tab.
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1. In the Category box, click Currency.
2. In the Options section, make sure that Decimal places is set to 2, Leading zeros is set to 1, and both check boxes are checked.

3. Click OK.

Borders And Shading

Borders can be used to separate data, mark certain cells or anything else you want. They are typically used to draw attention or separate. Add some borders to the check register worksheet:

Select A Block Of Cells

Use either of the following two methods;

Use Drag To Select A Block Of Cells
In A1, click and hold the click, then move the cursor onto G25.

Use The Shift Key To Select A Block Of Cells
Click A1. Press and hold down the Shift key then click G25.

Add A Border

1. Click Format > Cells...
2. Click on the Borders tab. Find the User-defined box. Notice that there are four boxes created by inward facing triangles.

3. Click to the left of the top left box . (Toward the middle of the box side.) (1)

4. Click between the top two boxes. (Toward the middle of the box sides.) (2)

5. Click to the right of the top right box. (3)
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1. You should have 3 vertical lines. Click OK.
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1. Select A1:G1. (Click "A1". Drag copy to "G1".)

2. Click the Borders, [image: image205.jpg]


, icon on the Formatting Toolbar.

3. Click on the second box from the left on the second row.

[image: image206.jpg]



Add A Background Color

1. Click Format > Cells...
2. Click the Background tab.

3. Click on Gray 20%. (Use tool tips to find it.)

4. Click the Borders tab.

5. Click on the bottom horizontal line in the User-defined box.
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1. Click the 2.5 pt line weight in the Style box.

2. Click OK.
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 Reference: The following tutorial is excerpt from Tutorials for OpenOffice, http://www.tutorialsforopenoffice.org/tutorial/Charting_Data.html
Data Relationship

The first thing you need is data that shows a relationship. Examples include mathematical functions, stock market prices over time, rainfall over time, statistical divisions of a population, or divisions of an income that make up a budget. Since math is something that anyone can duplicate, we'll use the sine function:

1. Go to the bottom of your workbook and click on Sheet2.

2. Type X in A1.

3. Type Sine(X) in B1.

4. Enter 0 in A2. (That's a zero. Click anywhere on the Spreadsheet to unselect “A2” after entering the “0”.)

5. Select A2. (Click on A2 again to select it.)  Drag-copy A2 down until you see the tool tip number read 90.  (Put the cursor over the box at the bottom right corner of "A2".  When you see a [image: image210.jpg]


, click on it and drag it down until you see the tool tip number read 90 then release the click.  The numbers will increase by 1 for every line you drag over.)  (The number 90 will be in cell A92)

6. Go back to the top and Select B2. (Ctrl+up arrow is a quick way to move up.)

7. Enter =SIN(A2).

8. Click on the bottom right corner of the B2 cell. (The "B2" cell contents change from the formula "=SIN(A2)" into a "0".) Drag-copy the formula all the way down to the 90 in the A column.

Don't worry if you don't know what the numbers mean; we aren't concerned with that. The order of the columns matters. Spreadsheet programs typically assume that the column on the left is the variable that is plotted on the horizontal (x) axis of the chart, and the column on the right is the variable that is plotted on the vertical (y) axis.

Insert Chart

1. Select columns A and B.

2. Click the Insert Chart, [image: image211.jpg]


 , icon on the Function Toolbar. (The pointer changes to[image: image212.jpg]


. Click anywhere on the spreadsheet. Or Click Insert > Chart... The "AutoFormat Chart" window appears.)

3. Select -New Sheet- from the drop-down box labeled Chart results in worksheet.
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1. Click Next>>>.

2. Select XY Chart. [image: image214.jpg]


 (Hold the cursor over the icons to find it.)

3. Click Next>>>.

4. Select Lines Only and check the X axis and Y axis grid line boxes. ("Y" may already be checked. Don't uncheck it.)
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1. Click Next>>>.

2. Give the chart a title, My First Chart, in the box that has Main Title in it. (Replace text.)

3. Click the X axis and Y axis check boxes.

4. Type X for X axis title, and Sine(x) for Y axis title. (Replace existing text.)

5. Click Create.
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1. Look at the worksheet tabs at the bottom.

2. Click on the last tab. (Probably labeled Sheet4.)

3. Use the little boxes on the corners to resize the chart by clicking on them and dragging them until you like the proportions.

Appearance Of Chart

Charts created by spreadsheet programs are unappealing most of the time. You have to mess with the format of the chart elements to make them look better.

The first thing I notice is a jagged plot line. That is appropriate for some data, but the sine function is a smooth function, so make the following changes:

1. Double-click somewhere on the chart if you see green boxes or no boxes.
2. Click Format > Chart Type...
3. Select Cubic Spline, [image: image217.jpg]


, from the Variants box at the bottom.

4. Click OK.

That's better, but it could still use some improvement. Try:

1. Click Format > Chart Wall.

2. Click the Area tab. In the dialog box below Fill, click the [image: image218.jpg]


 and select None. Click OK.

3. Place the cursor over the data plot line and double-click. (The smooth Purple line.)

4. Click the Line tab. In the Color dialog box, change the color to Sea Blue.
5. In the Width dialog box, change the width to .02. (Click the [image: image219.jpg]


 repeatedly or highlight the number in the dialog box and type ”.02”.) Click OK.

6. Select Format > Grid > All Axis Grids...
7. Change the Color to Gray 40%. (You have to scroll down the palette.) Click OK.

8. The chart still seems busy. Select Format > Axis > X Axis. Click the Scale tab.

9. Clear the Maximum check box and replace 90 with 45. Click OK.

10. Change the main title text to Sine Function by double-clicking on it and editing it.

11. When you are done, click somewhere else on the chart to accept the changes.

12. Click on a worksheet cell. Click Format > Sheet > Rename. (The “Rename Sheet” window appears.) Rename the sheet, Sine Graph.

13. Save your work. (Click “File > Save”.)

Open Office Impress
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Reference: The following tutorial is excerpt from Tutorials for OpenOffice, http://www.tutorialsforopenoffice.org/tutorial/What_Is_Impress.html.
IMPRESS is the presentation feature in OpenOffice. A presentation is pages that can be seen on the computer screen as normal and, with the use of a projector, the page can be seen on the wall or on an external screen. Normally, a laptop is used since it has good portability.
Impress is like a SLIDE SHOW. One page after the other is projected.

A page that is projected is called a SLIDE. The following can be included in a Slide:

1. Animation

2. 3-D graphics

3. Bullets and Numbered Lists

4. All the normal stuff that is in a word processor (Writer) and in spreadsheets such as bold, colors, text alignment, borders, drawing, templates (master slide) , etc.

Notes can be added to a slide that are not projected but can be seen by the presenter.

Use A Template

1. OpenOffice has two ready-made templates, Introducing A New Product and Recommendation Of A Strategy.
2. Click File > New > Presentation > From Template. (Part 1 of Window 1 of the “Presentation Wizard” appears.)
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1. If not already selected, select Introducing a New Product. Click Next (Part 2 of Window 1 of the "Presentation Wizard" appears.)
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1. In the dialog box under Select a slide design, click Presentation if it is not already selected. (Window 2 of the "Presentation Wizard" appears. Note that "Introducing a New Product" is highlighted. If you prefer another background than the default, under "Select a slide design", click "Presentation backgrounds" and select your choice.) In the dialog box under Select an output medium, click Slide.
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1. Click Next. (Window 3 of "Presentation Wizard" appears.) Under Select a slide transition, use the default for Effect and Speed. Under Select Presentation Type, click Automatic. In the Duration of pages dialog box, type 11 in the seconds place. In the Duration of pause, type 11 in the seconds place. (Highlight and type the numbers or use the [image: image225.jpg]


 to select a number. The format for the numbers is: 00.00.11. The "hours setting" is before the first decimal (period). The "minutes setting" is before the second decimal. The "seconds setting" is before the third decimal.)
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1. Note: If you use the default settings, click Create and you have your presentation ready for pictures, text. Etc.
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1. Under Describe your basic ideas, in the dialog box under What is your name or the name of your company?, type The Save Time Company. In the dialog box under What is the subject of your presentation?, type A New Watch. In the dialog box under Further ideas to be presented, type Use the Stopwatch Function and Use The Date Function.
2. Click Next. (Window 4 of the 'Presentation Wizard" appears.)
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1. Under Choose your pages, select what you want in your presentation or use the default settings. Click Create. (Note: "Next" is grayed. "Create" is the next step.)
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1. Click Slide Transition if it is not already selected. To see your presentation that you just made, click Slide Show.
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Save And Close Your Presentation

1. Click File > Save As. In the Save in: pull-down menu box, click My Documents (if it is not already selected). In the Save as type:" box, click OpenDocument Presentation (.odp) (if it is not already selected).

2. In the File name: box, type My Slide Show .
3. Click Save. (" My Slide Show" is saved. The file, "My Slide Show" is still on the screen.)

4. Click File > Close. (The file, " My Slide Show", is no longer on the screen.)

To Watch "My Slide Show” at a Later Time

1. Click File > Open. (The "Open" window appears.)

2. In the menu below the "Look in:" dialog box, click My Documents if it is not already there. In the menu below the File name: dialog box, click My Slide Show. ("My Slide Show" appears on your screen.)

3. Click Slide Transition if it is not already selected. To see your presentation that you just made, click Slide Show.
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 Reference: The following tutorial is adapted from http://www.tutorialsforopenoffice.org/tutorial/Automate_Slides_In_Your_Presentation.html.
Automate Slides In Your Presentation

Once you have created your Impress Presentation you might now want to automate the slides so that you don't have to click the mouse to move to the next slide every time.

	Activity
	Explanation

	1. Click File > Open .
	The "Open" window appears.

	1. In the menu below the Look in: dialog box, click My Documents if it is not already there. In the menu below the File name: dialog box, click the name of your Presentation. .
	Your Presentation appears on your screen.

	In the Tasks window, click Slide Transition.
	The "Tasks" window is on the right side of your "Impress Presentation" screen.

	Under Apply to selected slides, click the [image: image234.jpg]


 to scroll to select a transition like Wipe Down or Wipe right.
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	Click the [image: image236.jpg]


 to scroll to Fast in the dialog box to the right of Speed under Modify transition. Click Fast.
	In the "Speed "dialog box, you have three choices for the speed of the transition. The choices are "Slow", "Medium", and "Fast".

	Click Automatically after in the dialog box below Advance slide. Click the [image: image237.jpg]


 to set the Seconds to5sec.
	You can also highlight the number in the dialog box and type the number of seconds.

	Click Apply to All Slides.
	

	Press F5 to view your presentation to see if you have the speed and format the way you want it. If you want to change the speed or the type of transition you simply apply the process again.
	


Typing Skills
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 Reference: The excerpt below is from: The Importance of Daily Typing Practice, Burt Cotton, http://www.articles3k.com/article/319/110879/The_Importance_Of_Daily_Typing_Practice/. Copyright 2010 Articles3K.com, All Rights Reserved.
Like anything in life, ___________makes perfect. I am sure that you have heard that saying before. There is great truth to this fact. If you want to achieve anything in life, you will need to _________yourself to daily practice. This includes everything from playing the piano, competing in sports, and even mastering your typing skills. If you want to improve your typing skills then you will need to commit yourself to daily typing practice. Daily typing practice is the key to your typing success. Neglecting to practice will ensure that whatever gains you have made in speed and accuracy will be lost over time. There is no doubt about it. To keep up with your new skills and to improve your typing, you will need daily typing practice.

In today’s society, typing is the key to getting ____________. Most jobs require some degree of computer work, and knowing how to type quickly and efficiently will make you more marketable than your fellow worker who simply “finger pecks” at the keyboard. You can honestly state, that learning to type is an investment in your career future. Many public schools have embraced the importance of typing and they are encouraging children to schedule a time set aside for daily typing practice. Teaching children the correct methods of typing while they are young is an important step to ensuring their future success. 

Why is better typing productive for business and employees?
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 Reference: Why is better typing productive for business and employees?, http://www.typinginstituteofamerica.org/how-you-benefit.html. Copyright 2010, Typing Institute of America, All Rights Reserved.
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 Reference: Excerpts below from article “Reap the Benefits of Good Typing Skills” by Courtnie Packer, http://typing-tutor-review.toptenreviews.com/reap-the-benefits-of-good-typing-skills.html. Courtesy of Tech Media Network website. All rights reserved.     
Save Yourself and Your Boss Some Time

When you type properly at a faster pace, avoiding the hunt-and-peck technique, you can get a lot more done in a smaller amount of time.

It’s Not Only About the Keys
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This is the correct posture to type ([image: image244.png]


, source: http://www.nismat.org/ptcor/ergo)
Hands on practice

Let’s start with our typing lessons, the objective is to get familiarized with the keyboard layout memorize where are keys located.

1. Open Tux4Kids Typing tutor program. (Remember from previous lessons, we learned how to open computer programs in two ways: a) using the start menu to open the program and b) using the desktop shortcut to open the program)
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Navigation: to enter each section click the icon with the mouse. To exit each section press the ESC key on the keyboard.
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 from http://commons.wikimedia.org/wiki/File:QWERTY-home-keys-position.svg)

This is the correct way of placing your fingers over the keyboard, using all the fingers properly will allow us to type much faster.

Exercise # 1

1. Click on Lessons

2. Click on Lesson 1

3. Start typing!!!

Exercise #2

1. Click on fish cascade

2. Select easy

3. Select any category that you like.

4. Start typing!!!

Exercise #3

1. Click on Comet Zap

2. Select Space Cadet

3 Select any category that you like.

4. Start typing!!!

Contest

1. Click on Comet Zap

2. Click on Pilot

3. Start typing!!!

Introduction to the Internet

This is a brief history of the creation and evolution of the Internet.
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Reference: The History of the Internet in a Nutshell by Cameron Chapman, http://sixrevisions.com/resources/the-history-of-the-internet-in-a-nutshell/. Copyright 2008-2012 Six Revisions, All rights reserved. 
2012: Liberia’s High Speed Internet!!
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Reference: Liberians hope long wait for the web is finally over

By Bonnie Allen and Rob Hugh-Jones, PRI's The World, http://www.bbc.co.uk/news/world-africa-15692430. Copyright 2011 BBC, All rights reserved. 
The Future?

Where is the future of the Internet headed? Share your opinions in the comments section.

Other basic concepts: Intranet or Local Area Network, comparison with internet.

A local area network (LAN) is a group of computers and associated devices that share a common communications line or wireless link. Typically, connected devices share the resources of a single processor or server within a small geographic area (for example, within an office building).
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 by Dominio púlico, source: http://commons.wikimedia.org/wiki/File:Topolox%C3%ADa_en_%C3%A1rbore.png)  
Internet is…. Another definition of Internet
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Reference: What is the Internet, http://www.yourmaindomain.com/web-articles/what-is-internet.asp. Copyright 1998 - 2008 www.yourmaindomain.com, All rights reserved. 
Instant Messaging and Chat Systems

Computer instant messaging is a very commonly used way people communicate, collaborate and interact with friends, workmates or classmates. It allows people to exchange any type of information. With instant messaging systems a person can communicate using text messages with someone in the other side of the world!

There are many instant messaging communications software; some of them allow voice and video communication as well. It can be used to send files to the person you are talking to, or just to talk with.

Since our computer lab does not have internet access, we are going to use “Squiggle Messenger” which is a chat system for an intranet or Local Area Network. This program will allow you to communicate using text messages with another person across the room. Let’s Get started:

1. Start “Squiggle Messenger” by a double-click on the [image: image253.png]idess o
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  icon on the desktop

2. The program will open; type your first name and your last name, and the name of the camp as shown below. Check that it is spelled correctly, otherwise your peer will not be able to find you on the network.
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3. Press the [image: image255.png]s
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 button.

4. The chat window will open. On the “search contacts” section, type the name of the person that you are going to chat with, and press enter.
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5. Introduce yourself, tell your name and share your hobbies and interests.

6. We will discuss the following topics:

A. Topic one

B. Topic two

C. Topic three

 Software

· Tux Typing tutor, http://sourceforge.net/projects/tuxtype/ 

· Squiggle LAN chat, http://squiggle.codeplex.com/
Further Reading

· Open Office Writer User Guide, Linuxtopia, 2006, http://www.linuxtopia.org/online_books/office_guides/openoffice_writer_user_guide/index.html. CC:BY.
· Writer (Word processing) tutorials, Tutorials for OpenOffice, 2008, http://www.tutorialsforopenoffice.org/category_index/wordprocessing.html. CC:BY.
· Reap the Benefits of Good Typing Skills By Courtnie Packer, http://typing-tutor-review.toptenreviews.com/reap-the-benefits-of-good-typing-skills.html
· The Importance Of Daily Typing Practice, http://www.articledashboard.com/Article/The-Importance-Of-Daily-Typing-Practice/83385
· Why is better typing productive for business and employees?, Typing Institute of America, http://www.typinginstituteofamerica.org/how-you-benefit.html
· Mr. Peralta's Media Lab, http://www.emersonms.org/apps/pages/index.jsp?uREC_ID=50343&type=u&pREC_ID=307139
· Introduction to Computer Local Area Network (LAN) by Malik, 2010, http://en.ridwanaz.com/3301/gadget/networking/articles-introduction-to-local-computer-network-lan-local-area-network/.  

· The History of the Internet in a Nutshell by Cameron Chapman, 2009, http://sixrevisions.com/resources/the-history-of-the-internet-in-a-nutshell/. 

· Liberians hope long wait for the web is finally over by Bonnie Allen and Rob Hugh-Jones, http://www.bbc.co.uk/news/world-africa-15692430
· An Illustrated History of Computers - Part 4 by John Kopplin, 2002, http://www.computersciencelab.com/ComputerHistory/HistoryPt4.htm
Videos

· How Computers Work - Journey Into The Walk-Through Computer, Computer History Museum, 1990, http://www.youtube.com/watch?v=CoxQLJkLq1c
· When Computers Changed the World from the Revolution Exhibition, Computer History Museum, 2011, http://www.youtube.com/watch?v=aLg4MHyyqL0 
Calc Practice
In this lesson, we will become more familiar with using the spreadsheet in OpenOffice Calc. We will work through various spreadsheet examples, some of which are already loaded on your computer and/or USB drive. 

To begin, we will work on different formatting. 

1. Your instructor has a spreadsheet open that looks like the following:
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2. Please open the file “calc_practice.ods” that is either on your computer or on your USB drive. 

3. Now your spreadsheet should look like this:
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4. Please make your spreadsheet look like your instructor’s by carrying out the following formatting:

a. [image: image317.png][D)ey |



 Merge cells 3A; 3B; and 3C. 

b. Align cell 5A to the left; cell 5B to the center; and cell 5C toward the right. [image: image259.png]



c. [image: image318.jpg]


Change the font type in cell 7A to Broadway; in cell 7B to Cambria; and in cell 7C to 
Engravers MT.

d. [image: image319.png]


Change the font size in cell 9A to 12; in cell 9B to 14; and in cell 9C to 16.
e. [image: image320.png]


Make the text in cell 11E bold; make the text in cell 11F italic; make the text in cell 11G underlined.

f. [image: image321.png]


Fill the background in cell 13E to magenta; in cell 13F to yellow; and in cell 13G to blue.

g. [image: image322.png]
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Copy the text in cell 15A and paste in cells 15B and 15C. 

h. [image: image324.png]
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Cut the text in cell 17A and paste in cells 17B and 17C.

i. [image: image326.jpg]


Surround cells 19A, 19B, and 19C with borders.
j. [image: image327.png](<<



[image: image328.jpg]


Wrap the text in cell 21A. (Hint: first right click on the mouse with the cursor over the cell you would like to wrap, then use the images below as guidance)
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k. [image: image330.jpg]


Change the cell height in cell 23A to 0.5 inches. (Hint: first right click on the mouse with the cursor over the number of the row whose height you would like to change, then use the images below as guidance)
[image: image331.png]



l. Type in the time of 8:30 PM for the different styles in cells 25A, 25B, and 25C. (Hint: first right click on the mouse with the cursor over the cell you would change the date syle, then use the images below as guidance)
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Now we will practice with using functions with Calc. Go to “Sheet 2” on your practice spreadsheet. 

1. [image: image336.png]


Your instructor’s sheet should look like the following:

2. Your sheet should look like the following:
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3. Try to make your sheet match your instructor’s by doing the following:

a. [image: image338.png]B/ U



The most basic function is the “equals” sign, or rather “=”. For Basic Calculations and Functions, start by clicking on cell D5. Now, type “=” like this:

Finally, since we would like the cell in D5 to equal the “x” cell in this row, or rather to match the value in cell A5, click on cell A5 or type in “A5” like this:
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Now, press “Enter.” Your cell should now have a value of 100 in it, like this:
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[image: image342.png]


Do this with the next set of calculations in column D. Again, either click on the cell you would like to perform a calculation with, or type in the cell number. The following pictures are reference to how your cells should look before pressing “enter.”
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b. Now, we can practice with functions in which you must type the operator, rather than use a keyboard shortcut. The operator that you must type out for each calculation can be seen in column G. For the sum, follow the following steps. 

First, click on cell F15:

[image: image347.png]Row Height.




Now, type “=”. Remember, the “equals” sign is what tells Calc that you will be performing a function.
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The next step is to type in the word “SUM” followed by a left parenthesis “(’’. Notice how a yellow box pops up that has the following in it “SUM()”. This box means that the word you typed is a recognizable function by Calc. This box will pop up and give suggestions for any function you may be looking for. It will tell you exactly how to type the correct function.  

[image: image349.png]



Press “Enter” so that your cell now looks like the following:
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For the sum function, notice how a box pops up that looks like the following:
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This box means that all of the cells that you would like to sum together must have a semicolon “;” between them. Therefore, click on the cells that you would like to sum together. Be sure to type a semicolon between clicking on the cells. It should look like this:
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Now, press “Enter.” You should have been able to sum all of the values in those cells.
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Another way of summing all of the cells whose borders is all touching, is to click and drag over all of the cells. We will do this with the “Max” function.

First, type in “=MAX(” into cell F16, like the following:
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Now click on cell A16, and without lifting up the left mouse button, drag a box over cells A16, B16, C16, D16, and E16. It should look like this:
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Now click “Enter.” Your cell should now have the following result:
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Now, let’s practice this for the remaining cells in this section. 
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c. One of the most important features in a spreadsheet program like Calc is the ability to carry out calculations efficiently. There are many different shortcuts that can be taken to quickly create a spreadsheet. We will practice some of them now.

Go to cell F24. Carry out the same calculations that you practice above under the appropriate headings for row 24. Thus, carry out the calculations of “Sum,” “Max,” “Min,” “Average,” and “Median” in the respective cells of F24, G24, H24, I24, and J24. Once you do that, your solutions should match those of the instructor’s spreadsheet, which is the following:
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Click and drag a box over those same cells that you performed the calculations on. It should look like this:

Click on the little black box on the bottom of the corner of cell J24. It should be this box here:
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Hold down your click and pull the box down to cover the next two rows immediately below your highlighted cells, like this:

Now, let go of the click. The functions should have been calculated for the cells below using the corresponding values from columns A through E. This shortcut will copy and paste functions into cells that correspond to values in respective cells. 
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Let’s try it now with the dates in cells A28 and B28. Click and drag a box over those two cells like this:

Now, again, click on the little black box on the lower right hand corner of cell B28. Hold down the click and drag over to the right through column H. Now let go of the click. Notice how the new values are pasted into the cells corresponding to the cell’s location. Also notice how the formatting stays the same.
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Try it one more time with the time cells. Click and drag a box over cells A30 and B30. Now click on the little black box on the right hand corner of box B30. Drag the box to the right through column H. The values should have been copied like this:
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How to Develop a Computer Presentation

Creating clear and professional presentations is an essential skill for communicating ideas and technical information to others.  Open Office Impress is a free program for creating presentations.  A presentation is simply a set of slides or pages that can contain images, text,  charts, and tables.  Learning how to use this program and how to create a good presentation that is easy to understand and well delivered are the primary goals of these lessons.  

Learning Objectives

· Students will learn the basics of how to create and deliver oral presentations for communicating their ideas and data to a wide audience. 

· Students will learn how to plan, create, and deliver presentations (slide shows) and posters using the software program Open Office Impress.

· Students will learn how to tailor their presentations based on the context and target audience for which it is designed.
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 Reference: The following content is adapted from Preparing and Delivering Oral Presentations, The Cain Project in Engineering and Professional Communication, 2008, http://cnx.org/content/m16551/latest/. 
Basics to creating an effective oral presentation

The purpose of this first lesson is to introduce some general guidelines for creating and delivering good oral presentations.  No matter how amazing a project you create may be, if you cannot communicate the findings and importance of your work to others, its meaning and impact 

will be lost.  You will put the general guidelines for creating an effective presentation into practice by learning how to use Open Office Impress and creating your own presentations.

The first thing to consider is the audience that you are presenting to.  What is their background?   How much do they know already know about the topic you are presenting?  What level of technical detail will they understand?  Why is this information useful for them?  What message do you want to make sure they take away with them?  

The most important part of any presentation should happen before you even begin building your slides: coming up with a clear message or story to tell.  Next, knowing your overall message or story, you need to organize your thoughts.  Once they are organized, you can use Impress or another tool to help communicate your ideas.  

Creating an outline is a great way to organize your thoughts.  You can create an outline with a pen and paper, use word processing software such as Open Office Writer, or use the outline view in Open Office Impress.  Here is a generic outline to use for organizing your thoughts:

Introduction = Context + Motivation

· Why might your audience be interested in your issue? What is the point of mutual concern?

· What is the issue or problem?

· Why is it important?

· What is your thesis/recommendation?

· What topics will your presentation cover?

Body = Background + Analysis

· What are your key points–top 3 to 4 points?

· What evidence supports your points?

Conclusion = Summary +Recommendation

· What were your key points?

· What is your recommendation (if applicable)?

· What are the implications of your recommendation?

Where is this issue going in the future?

· Is more research needed?

· Reinforce the implication of factors you used to motivate your audience’s interest in the  introduction.

The next step is to break your outline into slides. For complex concepts, or if you want to 

illustrate your ideas with graphics, it's a good idea to mock up your ideas on paper or build 

thumbnail sketches.

This approach will save you lots of time because it's faster to brainstorm and improve your ideas 

on paper than on the computer.  Drawing thumbnails and tweaking them until you feel they will 

communicate your ideas effectively can work out ideas.  These preliminary drawings let you

work through your ideas and improve them. When the thumbnail drawing is done it will be your

blueprint.

Google Sketchup
The ability to create appropriate graphical communication skills is key for engineers and scientists who often need to convey their designs, ideas and plans with others.  Google Sketchup is a free software that allows you to create models and prototypes in three dimensions.  This is normally called Computer Aided Design or CAD.  With Sketchup you will not only be able to visualize your designs and ideas in three dimensions but also you will be able to create standard views needed to communicate with other.   

Learning Objectives

· Students will learn the general rules to create effective graphical communication pieces that convey their ideas and designs

· Students will learn how to use the basic features of Google Sketchup to create drawings, three dimensional models and plans

· Students will learn how to draw their designs using Google Sketchup and use those drawings in communicating their ideas to others

Lessons

4. Graphical Communication and Introduction to Sketchup

5. Drawing and Modifying Shapes

6. Push, Pull and Move

7. Components, Groups and Painting

8. Creating your Design

9. Adding Measurements

10. Follow Me

11. Rotate

12. Protractor

13. Creating Views

14. Text and 3D Text

15. A Presentation Ready Drawing

16. Copy and Arrays

17. Mirror

18. Drawing your Design

Introduction to Graphical Communication and Sketchup

In this lesson you will first learn how to draw objects by hand on isometric sketching paper.  You will learn the standard practices for drawing and the standard views of your drawing.  Finally you will be introduced to Sketchup software and how it can help you with the general concepts you learned.  

Instructions:

10. Follow the instructor as he shows explains the use of the isometric paper and standard concepts

11. Once the paper and pencil approach has been finished open Google Sketchup

a. Open the software by going to the start up button and clicking on Programs, move the mouse to Sketchup and double click the right button on the mouse

12. You may see the following screen:
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19. Click on the button at the bottom right corner that says “Start Using Sketchup”

20. The initial screen is as follows:
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20. Notice that opening screen looks three-dimensional.  There are three axes on the screen with solid lines marking the positive axes and dotted lines marking the negative axis.  

21. The picture of the women on the screen is provided for you to get reference of the depth and height of the screen.  Notice also the horizon line at the back of the picture.  

22. You are in essence looking at a picture of an empty world just ready for you to fill it up with drawings!

23. Click on the picture of the woman and press the delete button on your keyboard

24. There are four main ways of drawing on sketchup.  They are Line, Rectangle, Circle and Arc.  To draw those features you can click on their corresponding buttons at the top of your screen:
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7. You can also see that there is a tool called “Select”.  Every time you click on a drawing tool your cursor becomes that drawing tool and you will not be able to select other entitites until you click on the select tool

8. Follow along with your instructor as you learn to draw those different shapes in Sketchup

9. Make not that every shape is in a plane.  A plane is a two dimensional imaginary surface.  There are three main reference planes, the X-Y plane, the X-Z plane and the Y-Z plane.  They are the planes created by the surface delimited by the x and y axis, the x and z axis and the y and z axis respectively.  

10. For example, note the following rectangles aligned parallel with each of the three main planes

[image: image370.png]2
13
14
15
16
17
18

A

More functions...

23
23

05
05

67
6.7

F G

answer

123 76.5Sum
123 34 Max

RIR(R R

23

05

6.7

12.3=MIN(
T23-MINGEEEH

52

0F

e



[image: image371.png]A F G H
12 |More functions...

13 answer

14

15 34 23 05 67 123 76.5Sum

16 34 23 05 67 123 34 Max

17 34 23 05 6.7 123 0.5M

18 [ 34 23 05 6.7 2. ﬂ:AVERAGE(FE

19 7 23 05 67 123 —=——- |AVERAGE® number 1. number 2




[image: image372.png]A F G
12 |More functions...

13 answer

14

15 34 23 05 67 123 76.5Sum

16 34 23 05 67 123 34 Max

17 34 23 05 67 123 0.5Min

18 34 23 05 6.7 123 15.3 Average
19 [ 34 23 05 6.7

12.3=Median(A19: E19‘|

-

st iy —





7. The concept of planes will be very important going forward so make sure you keep up with your planes

Drawing and Modifying Shapes

1. Like we said, four main ways to draw shapes in Sketchup are lines, rectangle, circle or arc.  With these tools you should be able to create most any shape.  

2. Everything in sketchup, no matter how complicated is either a point, a line or a face.  You will really have to master these concepts to able to modify your shapes.  

3. A point is a single dot in space. 

4. A line is a series of points.  

5. A face is the surface encompassed by lines that do not have a break in between them and which are all co-planar (all lines are on the same plane).  

6. Look at the following figure and identify points, lines and faces.  Is there anything here that is not a face? Why?
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· Try now drawing a circle, a rectangle and a face of your choosing

· Modifying a face or object once you have created can be done with two main tools, although there are other ways.  The first tool is the “Move” tool.  
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· The key to using this tool successfully is to be able to select the part you want to modify first!  

· Use the selector tool and click on a line that you would want to move.  Now click the move tool and with it move the line to where you want it.  

· The other key to the move tool is to remember that this is a 3d software.  As such, once you click the move tool you must click on a reference point.  Then you can move the mouse and see how the line is moving and finally click on a last point where you want the line to be.  We recommend your first click to be on the actual line you are trying to move.  

· The next tool you can use is a little more intuitive and again, it depends on your correct use of the Select tool first.  

· Click on the select tool and then click on the face you would like to modify.  The face will turn dotted.  

· This tool is the scale tool.  To use it you must go to the menu’s on the upper toolbar of your screen and click on tools.  Scroll down to the “Scale” tool and click on it.    

· Your face will now turn to a yellow outline and will have green squares at several points.  

· You can grab these squares and move them to modify your shape.  
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· Notice that when you start moving your shape in one direction or another, there is a window above your drawing screen that shows the dimension.  If you want to modify the shape to a particular dimension in THAT particular direction you can stop moving the mouse and simply type the dimension.  No need to click on the dimension cell.  
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· Try now drawing a circle, a rectangle and a face of your choosing

· Modifying a face or object once you have created can be done with two main tools, although there are other ways.  The first tool is the “Move” tool.  
Push, Pull and Move

So far we have played in 2D.  But the beauty of Sketchup is how quickly you can turn your drawings into a 3D model.  Today we will do just that.  It all starts with the push/pull tool.  

· Open the file with the faces we drew before.  

· Now, click on the push/pull tool.  
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· Once you have selected the tool, your cursor turns into a miniature push/pull icon.  Hover with the cursor over the face you want to extrude into 3D. 

· The face turns dotted.  You can now click on it and move your mouse to expand it into a 3D model.  

[image: image379.png]27
28

A B

08/01/11 08102711

c

08/03/11

D

08/04/11

E

08/05/11

F

08/08/11

G

08/07/11

H

08/08/11,




· If you want to extrude the shape to a particular exact dimension you can just type that dimension and click Enter.  The face pops to that exact dimension.   

· Notice now that there are many more faces once you have extruded the original shape into 3D.  You can now push or pull on any of those faces!  

· Follow along with your instructor as you learn some more about these features.  

· Now our simple move tool and the procedures we used before become a little more complicated.  

· Because we now have 3D models we have to specify very carefully what we want to move!  

· Using the select tool properly becomes even more important.  

· You can now move a line, a face or the whole 3D model.  Also, note that because there is a 3D model attached to the line you are moving the results are much more fun.  

· Follow along with your instructor to explore this feature.  
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· The next thing is how to move a whole model or shape without deforming it.  

· Using your select tool, click and drag the mouse to create a square around the whole 3D model.  The model is now highlighted.  

· This allows you to move the whole model at once Notice that any part of your drawing COMPLETELY within the square you just dragged will become highlighted and therefore will be moved with the move tool

· Remember that the move tool needs two points in 3D space to work, a first click to move from and the second click to move to.  
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Groups, Components and Painting

We now know how to create 3D shapes.  We also know how to modify them by moving the edges or faces.  But what happens when we want to make our lives easier and start modifying a shape as a whole?  What happens when we want copies of that shape?  That is when groups and components become important.  

Let’s start by making a group.  

· Open your model with the 3D geometry you want to work with.  

· Using the select tool and the drag technique we learned earlier select your whole geometry.  The shape should now be highlighted.  

· Right click on the shape and click on the option that says “Make Group”  

· The highlight now changes to a large enclosing box.  
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· Click outside of your component.  Now click back on any part of it.  The big box comes back!  No matter where you click on the component the box comes back.  The program now thinks of this as one entity.  You can now move it, change its dimensions as a whole or make copies of it.  

· First let’s try moving it.  Follow along with your instructor as you use the move it tool from earlier to move the whole group.  

· Now, try scaling it.  Follow along as you use the scale tool from before.  

· Finally, let’s try copying it, or creating new instances of it (an instance is just a fancy name for a copy.  An instance of me would be a copy of me!)

· Select your group.  Go to the Edit menu above your screen and click on it.  Scroll down to the “Copy” option.  

· Now click outside your group.  Go back to the Edit menu and this time scroll down to the “Paste” option.  Click on Paste and you will see a new copy of your group appear on the screen.  Notice that your group moves with your mouse.  Click on the screen on where you want the copy to be.  
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· AS we mentioned before, the group is now a whole entity and you can only modify it as a whole.  But what if you want to modify the parts of your group?  You can “Explode” the group.  This basically undo’s the group command so you can now select again individual faces or lines inside the group.  

· Try it, right click on the group, scroll down to explode and click on it.  Now try modifying any part of the shape.  

Now, let’s imagine that you are designing a bunch of our little wedges we have been using.  You make one and then you create three copies of it.  But your boss comes back and says he wants a different size of the wedge.  Do you go back one by one and change them all?  Probably.  However you could have avoided having to do that by using the component feature.  Components are just like groups, except they are all tied to each other.  Anything you do to one component will happen to all the others.  Let’s see it.  

· Select your wedge just like you did before to create a group.  This time, click on the “Make Component” button.
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· Now a dialogue box appears.  Write the name of your component, this time we will call it wedge, and add a little description of what your component is then click the create button

.  
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· Once you have created a component you cannot change anything in it directly.  You can only move it, scale it or rotate it.  You can also create copies or instances of the component.  

· To edit the component you can double click on it.  The box around the component becomes dotted and you can now change things inside the component.  

· Follow along with your instructor to do this.  

· Once you have created a component it is stored in the model component list.  To access that list you go to the Window menu above your draw screen.  Then scroll down to “Components” and click on it.  The following dialogue box appears.  
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In this window there will be a list of the components you have created.  
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You can click on a component, hold down the button and drag it to your screen.  This creates an instance of the component.  Follow along as you create some instances of the components in your model.  

· Sketchup has a list of components already built into it.  You can access them by clicking on the arrow next to the home button in the component dialog then click on the folder that says “Components”

· Follow along with your instructor and explore using these ready-made components in your drawing! 

· Also, play with the ready-made components and see if you can edit them to fit your liking.   
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Up until now all our shapes and geometries look a solid color and we don’t get to choose it.  But look at the bench component we added earlier.  It is the color of wood!   Our drawings can use colors to help explain what we are trying to get across like material choice (using metal, concrete, bricks or sand).  They can also help differentiate or emphasize parts of our drawings.  

· To introduce color and texture to our design we can use the “Paint Bucket” tool.  Click on it in your upper toolbar.  

· The following dialog box appears.  

· Notice the buttons on the top of the box.  The crayon box allows you to pick simple colors, like picking out of a crayon box.  

· The brick button allows you to pick textures.  To use it you must click on it and then click on the drop down menu next to the house icon.  This lets you pick from a variety of textures like sand, brick, cement, glass, etc.  

· The next button, the picture, allows you to pick from almost an infinite number of colors, or a spectrum.  Click on it and then move your mouse inside the box below the house icon.  Notice the color of the box next to the magnifying glass change.  This is the color you are picking.  

· Notice that you can paint your components but the whole component turns the same color.  To paint a part of your component you must double click on it to edit it and then you can change the color of individual parts.  

· Follow along with your instructor as you play with painting.  
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Creating Your Design

So far we have focused on simple geometries.  Soon, we will be working on crafting our own bridges, machines and creations.  One of the best way to create these machines is to visualize them in 3D.  As engineers we often follow the technique of thinking about a problem, creating a possible solution, testing that solution and possibly iterating again until we find the best solution possible.  Part of testing a solution involves creating a prototype.  You will be building prototypes in your hands on lab.  However, to creat a prototype you must show others what your idea involves.  We will us Sketchup to make models of those designs and communicate to other what we want to do.  

This means that the closest our drawing are to what we want or imagine in our heads the better others will be able to follow that.  Simple geometries will no longer help in providing a picture but they will still be important as often we can create any shape by starting with simple geometries.  

Imagine you want to create a bridge.  How would you draw it?  How would you model it? 

We can use two different methods to make our life easier.  Both depend on simple geometries to come up with complicated figures.  

The first is the subtractive method.  This method is like carving a sculpture out of a large piece of wood.  We start with a big shape and slowly take parts away to come up with what we want.  

Follow the example:

· Open a new file in Sketchup

· Draw a rectangle 2 feet by 6 feet.  

· Use the push/pull tool and make the rectangle into a 3d shape with a height of 1 foot

· Orbit around your drawing until you see the back face of the rectangle
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Draw a rectangle that leaves .3 feet all around the base except for at the bottom

· To create the inner rectangle the easiest way is to the use the tape measure tool.  The tape measure tool will allow us to do several things, but for now we will focus on the “guide lines” feature. 

· For this feature to work you must make sure to click on a line, not a point, of your shape and then move away from it as you desire.  Type in the measurement “0.33’ “ and press enter. 

· A dotted line will appear at the appropriate distance.  

· Repeat these steps all around the back end of the rectangle.  
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Once the dotted lines are present you can see exactly where you want to draw!  Remember, you do not want to cross over lines you already have but the dotted lines are not “real”.  In other words you cant pull them or extrude them or make them a solid part of your drawing, they are just for your guiding.    

· You know have a face between a face.  

· Using your push tool, push the inside surface all the way to the back.  In essence, you are cutting away a chunk of the rectangle.  
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· Now orbit around your drawing to one side of your rectangle.  

· Follow your instructor as you draw guidelines to make your drawing look like the following figure.  
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· Using your pencil, make the bottom  and top guidelines solid.  

· Follow along with your instructor as you draw the lines on the next figure. 
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· Now, with your eraser delete all the guidelines on this side.  
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· Follow your instructor as you draw the next guidelines.  These will be at an angle!  However, because we are using the other lines we had already drawn these lines will be perfectly parallel to the previous lines.  
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· Now follow along with your instructor as you make the lines in the next figure solid and erase the guidelines.  
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· Cut away with your push tool the triangular faces that you have created.  

· This step is a little tricky, use your orbit and panning tools to make sure you see what you are doing and listen to the instructor trick about inferences!
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· You can see now how the subtractive method works.  To finish our bridge we could just repeat the steps above on the opposite side and we would wound up with a nice looking model as below.  
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Sometimes however, you will find it easier to work with the next method, the additive method.  Opposite to the subtractive method where we start with a big chunk and take little pieces away, this method starts with little pieces to put them together into one big piece.  In this method you will do well to keep in mind two concepts we have learned, components and groups. 

· First let’s draw a single rectangle 0.5 m wide by 4 m long.  

· Now, pull it to have a height of 0.5 m.  

· Make another rectangle the exact same dimensions.  

· Now move the first rectangle until you touch the other rectangle.  
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· Try moving the rectangle again.  

· As you can see the rectangles are now joined and you cant move them separately.  This is what is called “Sticky Geometry” in Sketchup.  

· Let’s try using a new tool, the polygon tool.  We will use it to create an equilateral triangle.  

· Click on the polygon tool and notice the top of the screen asking for a number of sides.  

· Now create a triangle with 2 m sides. 

· Use your move tool to put the triangle at the origin on the blue and red axis.  
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· We will now use another new tool, offset.  This tool basically takes the shape you created and copies it but an offset distance.  Follow along to create the following figure.  
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· Follow along as you create the following guidelines and line.  

· Now delete the inside face of the triangle and the top small triangle we just created.  
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· Pull your figure to a width of 0.25 m.  

· Make it into a group
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· Create three copies of your group and arrange them corner to corner along the red axis.  
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· Create 2 rectangles of dimensions 0.25m x 0.25m x 2.75 m and arrange them as in the figure below
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· Create a rectangle that is 0.25m x 0.25m x 10.9m.  Place it under your groups.  
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· Highlight everything in your picture and create a component out of it.  Call your component “Truss”.  Make another instance of your Truss and place 3 m away from your initial truss on the green axis.  
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· Create a rectangle that is 0.5 m thick and covers both of your trusses entirely.  
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· You now have a nice bridge!  Paint it according to your liking!  

Adding Dimensions

You now have made at least two models of designs people may actually build.  However, if you give those designs to somebody they will not be able to build them.  The reason is that they do not have any dimensions.  We will add dimensions to your model.  

· Open the last model we worked on.  

· Use the “Dimension” tool (it sits next to the tape measure).  Click on it.  

· Click on one corner of your bridge model, drag the cursor to the opposite corner and click again.  

· Drag your cursor down to where you want the dimension to appear and click again. 
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· You will need to repeat this process to add as many dimensions as you need so that someone who can not talk to you may actually build a prototype of the plans you have laid out.  

· A good practice is to start all your dimension marks from the same corner.  This will eliminate measurement errors.  The reason for this is that out on the field there is a small error in measurement due to the tool used to measure.  If you measure from one corner to the next feature and then measure from the next feature to a third feature, you have added two times the measurement error. 
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· By adding dimensions in the described way, all the measurements are relative to one point and the builder/engineer/foreman should follow the directions eliminating some of the errors of measurement.  

· Create all dimensions needed on your drawing. 

· Let your instructor see your drawing before finishing.   

· When adding some of your dimensions you will see that the numbers appear blurred by the lines that mark the dimension.  This will not be acceptable for somebody trying to read your drawing.  

· Right click on your dimension and scroll down to dialogue box option “Text Position”.  Click on any of the options and see how it changes the appearance.  Chose the appropriate one to make your drawing legible.  

· The following figure shows some of the needed dimensions.  
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Follow Me and Rotate
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Up until now we have been doing things pretty square!  What happens when you want something a little more sophisticated or with some curves?  How do we make shapes that are not uniform from the top to the bottom?  How do we curve things?  One of the answers is the “Follow me” tool.  This tool is very powerful and allows you much more flexibility in creating designs.  

We have also been pretty stiff about our shapes. We place them in one spot and we can move them around.  But, we have not been able to rotate our pieces.  We will learn how to do that today.  

· Notice the position of both tools on your toolbar. 

· Start by creating a circle at the origin point of your axis.  Make your circle 0.5 m in diameter. 

·  Use your arc tool to create an S shape moving up from the center of your circle.  
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· Click on your “Follow Me” tool.  

· Click on the surface of the circle.  

· Now follow the S shape with your cursor.  When you get to the end click again.  
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· The two keys to using follow me is to have a shape and a path that the shape will follow.  In the above example the shape was the circle and the path was the S we drew.  

· Your shape and your path have to be perpendicular to each other so that the follow me will work easier.  

· Now imagine you want to create a shape that has a decoration in it.  Like the leg of a chair.  The follow me tool is great to create such shapes.  

· Lets draw a rectangle that is 1 m by 0.25 m.  

· Draw the following shape on the rectangle using the pencil and arc tools.  

· Erase the outside shapes.  

· Draw a circle at the bottom of the shape with the center at the right corner and the end of the radius at the left corner.  Remember it needs to be perpendicular.  
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· Here is a short cut for working with Follow Me.  Use the select tool and click on the circle.  The outline of the circle is now the path.  

· Click on the Follow Me tool and then click on the white surface.  Automatically the follow me tool realizes that you wanted to follow the circle since you had previously selected it and does the work automatically.  

Imagine you drew your shape but you now want it to be horizontal instead of vertical.  How can you do that without starting over?  The answer is the rotate tool.  The rotate tool is very frustrating and difficult to use.  The reason is that we are not used to thinking of the computer screen in 3D.  The rotate tool needs you to give it a reference point, just like the move tool, then a radius of rotation.  The radius tells the tool along what circle to rotate.  Finally you can move the mouse to see the rotation happen and click where you are satisfied with it.  A protractor appears that helps you look at the degrees of rotation.  

· Lets try this with our chair leg.  First make your chair leg into a group.  This makes the process easier.  

· Now click on the rotate tool.  Move the cursor to the leg chair and notice how the protractor appears.

· Position the cursor on the bottom edge of your group blue lines and click.  This will be the center of rotation.  

· Now move your mouse to the top of the leg.  This will be the radius of rotation.  Click again.  

· [image: image429.png]


As you now move your mouse notice how the shape moves along the protractor rotating as you go.  Rotate the shape 90 degrees to the right.  It should now be on the red axis.    

· Experiment with the tool to rotate the piece in different ways.  

Protractor
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Using the rotate tool involved the protractor.  As you know, this is a tool to measure angles.  Just as the tape measure allowed us to measure shapes and create guidelines in straight paralelel and perpendicular lines, the protractor will help us measure angles and create guidelines at particular slopes.  However, the protractor will allow us to do even more down the road.  
· Notice the position of the protractor on your toolbar. 

· Open your bridge model where you created all the dimensions.  

· For the protractor tool to work you must click three times. 

· First click on the corner of the angle you wish to measure. 

· Then click on the first line or edge that creates the angle.  

· Finally move the mouse up towards the second line that creates the angle.  
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Notice that the measurement window above your drawing shows you the value of the angle.  In our case this should be 60 degrees.  

· Once you click for the final third time on the line, the protractor creates a guideline that follows that line.  If you do not want the guideline just press the Escape key on your keyboard.  

· Let’s say that you want to create a member on your bridge that is exactly 20 degrees slope from one end.  

· Click on your protractor tool.  Then click on the top right corner of your bridge.  

· Move your mouse down and click on the right edge of your bridge.  

· Now move the mouse away from the edge and type 20 then hit enter.  

· The protractor creates a guideline at exactly 20 degrees from the edge.  
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· Follow along with your instructor as you create the member using the guidelines, your pencil tool and inference points.  

Creating Views

Once you have your model in a well detailed state you still need to put it in a package so that others can see it and read.  You can not assume that your co-workers, clients or employees have the same software on the field.  Therefore it is important to create standard views.  Sketchup makes this taks a breeze.  

Above your drawing screen there are a series of “Standard Views”.  These buttons will let you create the views instantly.  
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· Open your bridge design with the dimensions on it.  

· Use the buttons to create front, back, side, top and iso views. 

· They should look like the following figures.  
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Adding Text

Sometimes your model and drawings will need explanations beyond the measurements.  For example, you may want to identify the materials to be used in construction, spell out the actual orientation of a model, or simply add instructions for builders.  In Sketchup you can do this with many options.  We will be using two main tools: “Text” and “3D Text”.   
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· Open your bridge model.  

· Click on the text tool and then click anywhere on the drawing screen.  

· Type in a title for your model like “My Bridge Model”.  Then click away from the dialogue box. 

· You have now created a simple window text.  

· Orbit and pan around your drawing.  You will notice that the text you typed in does not move with your model.  It seems as if it is written on the actual window, hence it’s name “Window Text”.  
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· A different type of text that we often need is called “Annotation”.  This type of text is actually attached to a part in your model.   

· Click on the text tool again.  Move your mouse over the surface of the top of your bridge.  Notice how the inference point appears.  It will give you information of what you are hovering over, surface, edge, point, etc.  

· Click on the surface, drag your mouse and click on the screen.  Notice that the text now actually shows information about the entity you clicked on.  In this case it automatically tells you the area of the surface.  It would tell you the length of a line if you were to click on an edge.  

· Type in the text box “Asphalt Surface”.  
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· As you move and orbit around your model you can see that the text moves with your model.  It is now attached to that particular point where you clicked on.  

· You can click on your text and move it around to get the right placement.  

· Right click on your text and choose “Entity Info”. 

· Here you can change several options to format your text and the arrow that point to the desired entity.    

· You can change the text, the text font, size and color.   You can also change the type of arrowhead on your drawing.  

· When you change the font of a text, you can actually give it real dimensions.  This means that as you zoom in and out the text will also change size.  

· To do this click on the “Font” button and a new dialogue box appears.  
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Click on the “Height” option.  Now type in a real dimension, like 2 m.  

· You can see that your text takes on the real dimensions you gave it.  As you zoom in and out, your text also zooms in or out.  This is because of your choice.  

· All annotations are tied to the entity you selected when creating them.  

· If you change the entity, the text will also move.  Try moving your surface and notice how the text moves around.  

· You can also change groups of text all at once.  This keeps you from having to select each text and make the same changes over for each one.  

· To do this click on the “Window” pull down menu at the top of your screen.  Then pick “Model Info”.

· On the left hand side of the dialogue box that appears click on “Text”.  
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· Notice how you can select all screen text, all leader text, or all leader lines at once.  You could also select just a few lines of text before accessing this menu and change only those.  
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Once you are done creating changes click on “Update Selected Text” and your selected lines will change.  

The next tool will actually create model geometry in the shape of text.  

· Click on the “3D Text tool”. 

· A dialogue box opens.  Type in your name.  

· [image: image455.png]


You can change many settings here for your text.  You can change the alignment of the text, the size, the font and the extrusion.  Extrusion is another word for what your push/pull tool does to a 2D shape.  In other words it creates another dimension of a certain height.  

· Now click on place.  

· Your text appears on the screen ready to be located where you want.  

· Move the text around and notice how it can align itself to any of the surfaces you have created.  

· Let’s put your name on the bridge truss.  

· Your 3D text is actual geometry.  So you can modify it just like you would any other shape in your model. 

· Paint your name a different color.  

· Your text is a group.  Double click on it to modify it.  

· Pull on each individual letter to make them different heights.  
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· Click outside of the text with your select tool.  

· Right click on your 3D group and select explode.   This separates the letters into individual geometries.  You can actually do this with any group you want to separate the individual pieces of a group.  

· You can now change the letters around.  Move them to different places.  

· This is a good way to personalize your models or add flair and different aesthetics.  
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A presentation Ready Drawing
So far we have enjoyed the 3D models views we have been creating.  Unfortunately, we cannot always count on the software we are using being available so that we can show our models.  In these cases we must prepare an appropriate drawing that can easily be inserted in a presentation or a report.  For this we will need to make sure our drawing has the appropriate annotations, good dimensions, a title and a text box that provides information about the drawing and the author of the drawing.  We can then “export” our drawing to an image that can be easily used in a presentation or report.  

· Open the your bridge model.  

· If you still have it in your model, delete the 3D text we added.  

· The first thing we want to do is choose the view we would like to create.  

· Orbit your model so you can see an iso view of the bridge.  

· So far, we have happy with the way the dimensions appeared.  But, we would like to make them look a bit more clean.  

· [image: image458.jpg]


Select the “Window” drop down menu and click on “Model Info”.  Then choose the “Dimensions” option on the left hand side of the window.  

· Click on “Select All Dimensions” and click on “Align to dimension line”. 

· Click on the drop down menu and choos “Outside”.  

· Click on “Update Selected Dimensions”

· Now all your dimensions are aligned to your lines.  The numbers should not be blurred by the dimension line.  

· Your model should look like the following figure.  
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· Change your title to something more appropriate.  Double click on the title and type in “Proposed Bridge for Community of Yandahoun”.  

· [image: image460.jpg]


Right click on the title and choose “Entity Info” to change the font to bold and size 24 point.  

· Insert “Screen Text” at the bottom right corner of your model and type the following information:

Prepared by: Your Name
Created: Today’s Date

Last modified: Today’s Date

EHELD Program

Summer Start
· This information communicates to people who the author of the model is, the date it as created, any modifications and their date and also the company or program associated the designer is associated with.  
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· We are now ready to create an image for our presentation.  

· Click on the “File” Menu, scroll down to “Export” and move over to “2D Graphics” and click.  
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· A dialogue box appears:  enter the name you wish to give your file and the place where you want to save your file.  

· Click “Export”. 

· Your model is now saved at the location you picked, under the name you entered as an image file of type .png  

· Open the file you have created and make sure it looks to your satisfaction.  Sometimes, the export process may “cut” certain parts of your drawing.  You may need to use a little trial and error.  
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· You can now insert this image in presentations and reports.  
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�


� Source: � HYPERLINK "http://openclipart.org/detail/27362/postcard-by-coredump-27362" �http://openclipart.org/detail/27362/postcard-by-coredump-27362� 





�


� by Gerard van de Garde, source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:Piteba_oliepers_-_Help_Ghana_op_gang.JPG" �http://commons.wikimedia.org/wiki/File:Piteba_oliepers_-_Help_Ghana_op_gang.JPG� 





�


� by Haarvey, source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:Oil_press_FAES.jpg" �http://commons.wikimedia.org/wiki/File:Oil_press_FAES.jpg� 





� 


� Image: U.S. Geological Survey, Wikimedia Commons, � HYPERLINK "http://commons.wikimedia.org/wiki/File:Aquifer_en.svg" �http://commons.wikimedia.org/wiki/File:Aquifer_en.svg�. 





�


� Source: � HYPERLINK "http://openclipart.org/detail/11554/rpg-map-symbols:-wishing-well-by-nicubunu" �http://openclipart.org/detail/11554/rpg-map-symbols:-wishing-well-by-nicubunu� 





�


� Source: � HYPERLINK "http://openclipart.org/detail/38857/water-droplet-by-mbalax" �http://openclipart.org/detail/38857/water-droplet-by-mbalax� 





�


� by cybergedeon, source: � HYPERLINK "http://openclipart.org/detail/170521/eco-green-watering-icon-by-cybergedeon-170521" �http://openclipart.org/detail/170521/eco-green-watering-icon-by-cybergedeon-170521� 





�


� by Brendel, source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:Irrigation_system.JPG" �http://commons.wikimedia.org/wiki/File:Irrigation_system.JPG� 





       �


Figure 1: A circuit board like the one shown here is crucial to almost all complex electronic devices, and is designed by electrical/computer engineers. 


� by Jörgen Nixdorf , source: � HYPERLINK "http://en.wikipedia.org/wiki/File:MOS_Technologies_large.jpg" �http://en.wikipedia.org/wiki/File:MOS_Technologies_large.jpg�  








�


Figure 2: The beautiful city of Hong Kong is lined with dozens of skyscrapers and buildings, all planned and designed by civil engineers.


� by Kent Wang, 


source:� HYPERLINK "http://commons.wikimedia.org/wiki/File:Hong_Kong_skyline_night_lights.jpg" �http://commons.wikimedia.org/wiki/File:Hong_Kong_skyline_night_lights.jpg� 





�


Figure 3: Tractors built by agricultural engineers have revolutionized the farming industry. 


� by Lucarelli, source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:Same_Tiger_Six_105_tractor.jpg" �http://commons.wikimedia.org/wiki/File:Same_Tiger_Six_105_tractor.jpg� 





�


Figure 4: Together with electrical engineers, mechanical engineers build robots like the one pictured here. 


� by Milky, source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:Robot_Asimo.jpg" �http://commons.wikimedia.org/wiki/File:Robot_Asimo.jpg� 








                                         �


Figure 5: Biomedical engineers work with mechanical and materials engineers to develop prosthetic (artificial) limbs, such as the leg fitted to the man in this picture.


� by Virginia Reza, source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:Army.mil-2007-02-07-103140.jpg" �http://commons.wikimedia.org/wiki/File:Army.mil-2007-02-07-103140.jpg� 
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Figure 6: Aerospace engineers develop the machines that allow us to fly through air, and into space.


� by Kirbstr, source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:Space_Shuttle_Discovery_Transport.jpg" �http://commons.wikimedia.org/wiki/File:Space_Shuttle_Discovery_Transport.jpg� 








a) �  b) � c) �


Figure 1: a) A horse-drawn plow used up until the invention of the tractor. b) An early tractor powered by a steam engine. c) The modern day tractor, a remarkable engineering feat that is so crucial to agriculture.


� “Horse-drawn plow” by Ferox Seneca, source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:Chinese_farmer_1.jpg" �http://commons.wikimedia.org/wiki/File:Chinese_farmer_1.jpg� 


�  “Old tractor powered by steam engine” � HYPERLINK "http://commons.wikimedia.org/w/index.php?title=File:Photograph_with_caption_%22Excavator_on_Mile_52_being_pulled_by_traction-engine,_plow_side._August_8,_1904.%22_-_NARA_-_282335.tif&page=1" �http://commons.wikimedia.org/w/index.php?title=File:Photograph_with_caption_%22Excavator_on_Mile_52_being_pulled_by_traction-engine,_plow_side._August_8,_1904.%22_-_NARA_-_282335.tif&page=1� 


� “Modern tractor” by Brian Robert Marshall, source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:A_field_near_Winterbourne_Monkton_-_geograph.org.uk_-_970926.jpg" �http://commons.wikimedia.org/wiki/File:A_field_near_Winterbourne_Monkton_-_geograph.org.uk_-_970926.jpg� 





�  �


Figure 2: The watermill (left) used in Belgium converts the translational energy of the flowing water into mechanical energy that can be used to run various processes, through the mechanism seen in the right picture.


� “Water Mill in Belgium” by Spotter2, source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:Schorisse_%28Maarkedal%29_-_Water_mill.jpg" �http://commons.wikimedia.org/wiki/File:Schorisse_%28Maarkedal%29_-_Water_mill.jpg� 


� “Water Mill Mechanism” by Chrkl, source: � HYPERLINK "http://commons.wikimedia.org/wiki/User:Chrkl" �http://commons.wikimedia.org/wiki/User:Chrkl� 
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Figure 3: Irrigation systems have been engineered to provide water to crops without having to depend on rainfall. This engineering feat is greatly useful for the agricultural community. Various types of irrigation systems include (A) large sprinkler systems, and (B) small, focused drip systems, where water drips directly on to the root of the plant. 


� “Irrigation” by Paulkondratuk3194, source: � HYPERLINK "http://en.wikipedia.org/wiki/File:Irrigation1.jpg" �http://en.wikipedia.org/wiki/File:Irrigation1.jpg� 


� “Drip Systems”, source: � HYPERLINK "http://greenfieldgeography.wikispaces.com/Irrigation+and+agriculture" �http://greenfieldgeography.wikispaces.com/Irrigation+and+agriculture� 


� “Drip Emitter” by Alan.ca, source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:Drip_emitter.jpg" �http://commons.wikimedia.org/wiki/File:Drip_emitter.jpg� 
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Figure 4: The general process of genetic engineering. In order to force a plant to express a certain chemical or property, scientists transfer the necessary gene into the plant by extracting them from things that do express them (like bacteria). They then breed the original plant with plant cells that express the target property, and the resulting plant has the trait that they want!








�


� Source: DNA-Project-Cydney, � HYPERLINK "http://dna-project-cydney.wikispaces.com/Part+3" �http://dna-project-cydney.wikispaces.com/Part+3�








�  �


Figure 5: (A) Thai farmers spray chemical insecticides on their crops to prevent harmful pest infestation. The protective gear they were indicates the toxicity of such chemicals. (B) The genetic modification of crops by adding an insecticide gene prevents and kills any harmful pests that try to infect the plants.





� “Thai farmers spray insecticides”, source: � HYPERLINK "http://ricehoppers.net/2011/05/what-stimulates-farmers-in-chainat-thailand-to-apply-prophylactic-sprays-of-resurgence-causing-insecticides/" �http://ricehoppers.net/2011/05/what-stimulates-farmers-in-chainat-thailand-to-apply-prophylactic-sprays-of-resurgence-causing-insecticides/�   


� “Bacillus Thuringiensis” by Hardy Hall, source: � HYPERLINK "http://www.scq.ubc.ca/bt-corn-is-it-worth-the-risk/" �http://www.scq.ubc.ca/bt-corn-is-it-worth-the-risk/� 




















�


� Source: � HYPERLINK "http://openclipart.org/detail/5333/-by--5333" �http://openclipart.org/detail/5333/-by--5333� 





��
�
� Source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:Resume.pdf" �http://commons.wikimedia.org/wiki/File:Resume.pdf� 








�


� Source: � HYPERLINK "http://openclipart.org/detail/48937/trophy-by-sheikh_tuhin" �http://openclipart.org/detail/48937/trophy-by-sheikh_tuhin� 
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�


� Source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:Hand_auflage_pad_pillow.jpg" �http://commons.wikimedia.org/wiki/File:Hand_auflage_pad_pillow.jpg� 





�


� Authors: Ryan A. Gillis, Crystal Gillis, source: � HYPERLINK "http://openclipart.org/detail/121969/stars-by-cgillis73" �http://openclipart.org/detail/121969/stars-by-cgillis73� 





�


� Source: � HYPERLINK "http://openclipart.org/detail/630/thinkingboy-outline-by-ryanlerch" �http://openclipart.org/detail/630/thinkingboy-outline-by-ryanlerch� 





�


� Source: � HYPERLINK "http://openclipart.org/detail/57067/handshake-with-black-outline-(white-man-hands)-by-palomaironique" �http://openclipart.org/detail/57067/handshake-with-black-outline-(white-man-hands)-by-palomaironique� 








�


� Source: � HYPERLINK "http://www.flickr.com/photos/9110880@N04/7636476418/" �http://www.flickr.com/photos/9110880@N04/7636476418/� 





�


� Source: � HYPERLINK "http://pixabay.com/en/appointment-clock-countdown-15979/" �http://pixabay.com/en/appointment-clock-countdown-15979/� 





�


� Source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:FEMA_-_37835_-_Coast_Guard_at_the_Joint_Field_Office_in_Louisiana.jpg" �http://commons.wikimedia.org/wiki/File:FEMA_-_37835_-_Coast_Guard_at_the_Joint_Field_Office_in_Louisiana.jpg� 





�


� by Enh lepree, source: � HYPERLINK "http://commons.wikimedia.org/wiki/File:Wan.gif" �http://commons.wikimedia.org/wiki/File:Wan.gif� 
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